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IMPORTANT INFORMATION
Like any electrical appliance, the ATARI MEGA ST Computer uses and produces radio­
frequency energy. If not installed and used according to the instructions in this manual, 
the equipment may cause interference with your radio and TV reception.

If you believe that this equipment is causing interference with your radio or TV reception, 
try switching the eguipment off and on. If the interference problem stops when the equip­
ment is switched off, then the equipment is probably causing the interference. You may 
be able to correct the problem by trying one or more of the following measures:
• Adjust the position of the radio or TV antenna.
• Reposition the equipment in relation to the radio or television.
• Move the equipment away from the radio or television.
• Plug the equipment into a different wall outlet so that the equipment and the radio or 

television are connected to different branch circuits.

If necessary, consult your ATARI Computer retailer or an experienced radio-television 
technician for additional suggestions.

A resource that you may find helpful is a booklet prepared by the Federal Communica­
tions Commission: How to Identify and Resolve Radio-TV Interference Problems. This 
booklet is available from the U.S. Government Printing Office, Washington, DC 20402, 
Stock No. 004-000-00345-4.

WARNING: This equipment has been certified to comply with the limits for a Class B computing 
device, pursuant to Subpart J of Part 15 of the FCC rules. Those rules are designed to provide 
reasonable protection from interference when the equipment is used in a residential setting. 
However, there is no guarantee that interference will not occur in a particular home or residence. 
Only peripherals (computer input/output devices—terminals, printers, etc.) that have been 
certified to comply with the Class B limits may be attached to this computer. Operation of 
noncertified peripherals with this computer is likely to result in interference with radio and TV 
reception. Shielded cables should be used on all I/O connectors (except the joystick and mouse 
connectors); otherwise, radio emissions may exceed Class B limits.

Every effort has been made to ensure the accuracy of the product documentation in this 
manual. However, because Atari Corporation is constantly improving and updating its com­
puter hardware and software, it is unable to guarantee the accuracy of printed material after 
the date of publication and disclaims liability for changes, errors, or omissions.

ATARI, MEGA ST, MEGA ST1, MEGA ST2, MEGA ST4, ST, and TOS are trademarks or regis­
tered trademarks of Atari Corporation. Epson is a registered trademark of Epson America, 
Inc. GEM is a trademark of Digital Research Inc. VT is a registered trademark of Digital 
Equipment Corporation.

Reproduction of all or any portion of this manual is not allowed without the written 
consent of Atari Corporation.

AATARI
Copyright ©1987, Atari Corporation 
Sunnyvale, CA 94086 
All rights reserved.
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INTRODUCTION
Welcome to the ATARI MEGA ST Computer
The MEGA ST Computer system is the newest generation of ATARI 
ST™ Computers. While remaining compatible with all previous sys­
tems, the MEGA ST offers additional features that increase its power, 
speed, and expandability:
• Enhanced memory—one, two, or four megabytes of directly 

addressable RAM, depending on the model—gives the MEGA ST 
the capacity to handle the most complex word-processing tasks or 
the most detailed spreadsheet procedures.

• A Blitter chip produces faster graphics operation both on the 
desktop and in graphics applications.

• An internal expansion connector direct to the computer’s main 
processing unit allows for future expansion of the MEGA ST’s 
capabilities.

• A real-time clock keeps the date and time continuously, with or 
without power to the computer, so your files are always cor­
rectly dated.

• The built-in ATARI MicroFloppy Disk Drive stores up to 357,376 
(single-sided) or 726,016 (double-sided) bytes of information on 
each disk. The addition of an external floppy disk drive or a hard 
disk can increase the computer’s memory capacity even further.

• The detached keyboard and stackable monitor make the MEGA 
ST an attractive as well as practical system for home or busi­
ness use.

The MEGA ST combines the latest microcomputer technology with 
an easy-to-use working environment. The computer’s operating 
system, TOS™, is permanently installed in memory, and includes 
GEM™, the powerful Graphics Environment Manager. Computer 
operations are represented by pictures and words on the screen; 
to operate your computer, you select items on screen using the 
mouse, and activate them by pressing a mouse button. Your 
MEGA ST communicates with you through dialog boxes, asking 
questions in order to complete an operation or warning you of pos­
sible errors before they happen.
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In addition, the MEGA ST offers a complete palette of 512 colors; 
low, medium, and high-resolution screen modes; an 80-column 
display; and expansive memory and disk storage. The ease of 
adding peripherals such as a hard disk, modem, parallel or serial 
printer, and music synthesizer greatly enhances the MEGA ST 
Computer’s potential for new and exciting uses.

Using This Manual
Operating your MEGA ST is easy, and you’ll get maximum results from 
your computer if you operate it correctly from the start. This manual 
explains how to do that in clear, non-technical language that computer 
novices as well as seasoned users can understand. After you become 
familiar with your computer, use this manual as a reference guide to 
individual procedures and specific information.

It is essential that you make a backup copy of the disk supplied with 
your MEGA ST Computer. (See Copying a Disk in Chapter 2 for 
instructions.) Having a backup copy of the disk safeguards you 
from accidentally losing or damaging the contents of your original 
disk. Once you make the copy, use it as your working disk and 
safely store the original.

MEGA ST Computer owners living in the United Kingdom should 
refer to Appendix E for additional instructions when connecting 
their system.

This manual’s chapters are designed to be read in sequence, 
proceeding in order from connecting your computer system, to a 
thorough explanation of system operation, and finally to advanced 
features. A summary of each manual section follows:

Chapter 1: Getting Started familiarizes you with the components 
of the MEGA ST Computer system. It explains how to unpack the 
computer and connect the system, and surveys the major features 
and available options.

Chapter 2: ST Computer System Overview explains how the com­
puter works, then introduces you to the GEM desktop and describes 
how to use it. The chapter includes instructions for write-protecting, 
copying, and formatting microfloppy disks.

Chapter 3: Icons, Windows, Files, and Folders explains how to 
manage information, both on screen and on disk, using the GEM 
desktop.



Chapter 4: The Menu Bar describes all menu bar headings and 
the options they provide, and thoroughly explains how to use them.

Chapter 5: Desk Accessories explains how to use the special 
applications available from the Desk menu.

Chapter 6: Advanced GEM Features describes the procedures for 
using special features that make working with your computer 
easier and more efficient.

Appendix A: Mouse Pointer Control Quick Reference is a chart 
describing mouse pointer actions and listing the ways to achieve 
them using either the mouse or keyboard. You can copy this chart 
and keep it near your system for quick reference.

Appendix B: Troubleshooting and Preventive Maintenance offers 
solutions to problems you may encounter while connecting or 
operating your MEGA ST Computer. The appendix includes guide­
lines for proper maintenance of your computer system.

Appendix C: MEGA ST Computer Specifications summarizes the 
major features and requirements of the computer.

Appendix D: Connector Pinout Specifications shows the pin 
assignments of the MEGA ST Computer ports.

Appendix E: Connecting a Three-Pin Plug to the Mains Lead 
provides additional set-up instructions for MEGA ST Computer 
owners in the United Kingdom.

Glossary defines common technical terms used in this manual as 
they relate to the MEGA ST Computer.

Index helps you locate terms and procedures used or explained in 
the manual.

Customer Support tells you where to find more information about 
the ATARI MEGA ST Computer and ATARI Computer products.

Paragraphs marked Note, Warning, or Reminder appear through­
out the manual. Notes contain useful hints and other information 
relevant to the topic being discussed. Warnings alert you to 
potential problems and suggest ways to avoid them. Reminders 
repeat information from other sections that is important to the 
topic at hand.





CHAPTER 1
GETTING STARTED
Connecting the MEGA ST Computer System
Your MEGA ST Computer system contains sophisticated electronic 
equipment which must be located in a proper working environment. 
When setting up your system, choose a place that would also be 
suitable for a stereo system or television. Allow adequate room for 
airflow around the fan vents on the top and back panels of the 
computer. Avoid locations that expose the components to dust, 
grease, extreme temperatures, direct sunlight, or high humidity.

Carefully lift the computer and keyboard out of the packing carton. 
Remove the packing materials and place the components on a 
firm, level surface. (Save all packing materials for shipping and 
storing your computer.) Then follow the instructions in this chapter 
for connecting your system.

Note: See Appendix B: Troubleshooting and Preventive Mainte­
nance for information on ST Computer system maintenance.

Computer and Disk Drive
Your MEGA ST Computer includes a built-in microfloppy disk drive. 
Depending on your computer, this drive will either be single-sided 
or double-sided. The disk drive is your primary means of storing 
and retrieving information with your computer. It is always referred 
to as drive A

Power L

Drive Busy Light



Make sure your computer is switched off and you’ve removed the 
protective insert from inside the disk drive. Plug one end of the 
power cable into the jack marked “Power” on the back panel of 
your computer. Then plug the cable’s three-pronged plug into a 
grounded wall outlet or power strip.

Back Panel 
of Computer

Connecting the power cable to your computer also provides power 
to your disk drive. When the light on the computer’s keyboard is 
illuminated, power to the computer and drive is switched on. When 
the drive is busy storing or retrieving data, the light alongside the 
drive illuminates and the drive whirs.

Clock Batteries
Your MEGA ST Computer contains a real-time clock that can main­
tain the time and date even while your computer is switched off. The 
clock requires two size AA batteries that fit into the battery housing 
on the top of the computer at the rear of the left fan vent.

To install the batteries, remove the cover of the battery housing by 
pressing on it and pulling it towards the front of the computer. Place 
the batteries in the battery slots, being sure to align the positive ( + ) 
and negative (-) ends of the batteries with the markings on the slots. 
Then set the cover back in place. Pull it forward, then push it down 
and back, to lock it in position.

Top of 
Computer

Battery Housing 
Cover

Size AA Batteries



Note: If you don’t have batteries available when you first connect 
the system, they can be installed later.

Mouse
The mouse is a hand-held device that connects to your MEGA 
ST Computer keyboard with a cable. By rolling the mouse on a 
tabletop and pressing the mouse buttons, you can control your 
computer.

To connect the mouse, turn the keyboard upside down. Insert the 
plug at the end of the mouse cable into mouse/joystick port 0 on 
the bottom of the keyboard. If you like, press the cable into the 
channel on the bottom of the keyboard, securing it with the cable 
grips. Remove the protective strip on the bottom of the mouse that 
holds the roller in place.

Bottom of



Keyboard
Much of what you will do with your computer will involve using 
keys on the computer keyboard. The keyboard also houses the 
mouse and joystick ports.

To connect the keyboard, plug one end of the keyboard cable into 
the keyboard jack on the left side panel of your computer. Plug the 
other end into the matching jack on the back of the keyboard.

Keyboard Cable

Adjustable legs on the bottom of the keyboard let you raise or 
lower the component to its best typing position. To raise the key­
board (for instance, when it’s placed on a low tabletop) swing the 
legs out to the raised position. Push the legs back into their 
original position to lower the keyboard.



Monitor
The monitor provides the video display for the MEGA ST Computer, 
enabling you to see what’s going on. This makes effective communi­
cation between you and your computer possible. You can attach 
either an ATARI High-Resolution Monochrome Monitor or an ATARI 
RGB Color Monitor to your computer system. Both monitors are 
designed to fit on top of the computer.

To connect the monitor, plug its video cable into the monitor first 
(if it is not already attached), then into the jack labeled "Monitor” 
on the back of the computer. Connect the monitor’s power cable 
to the monitor, then plug it into a grounded wall outlet or power 
strip. (Consult the manual supplied with your monitor for further 
information.)

Back of Monitor
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A Second Floppy Disk Drive
In addition to the disk drive built into your computer, you can connect 
a second, external disk drive to your computer system. A second 
drive streamlines the processes of data storage and retrieval.

To connect a second disk drive, make sure both the computer and 
disk drive are switched off and you’ve removed the protective insert 
from inside the drive. Plug one end of the drive’s interface cable into 
the port labeled “Floppy Disk” on the back of the computer. Plug the 
other end into the port marked “In” on the back of the drive. Insert 
the round plug on the drive’s power adapter into the jack labeled 
“Power” on the back of the disk drive. Then plug the power adapter’s 
three-pronged plug into a grounded wall outlet or power strip.

To Power

Back Panel of Computer

Back Panel of Disk Drive

Note: You can connect a maximum of one external floppy disk 
drive to your MEGA ST Computer system. The computer always 
refers to the external floppy disk drive as drive B.

10



Switching On the System
Use the microfloppy disk supplied with your MEGA ST Computer 
when you switch on your computer. This disk contains information 
your computer needs during power-up.

Note: It's important to make a backup copy of the disk supplied 
with your MEGA ST Computer. Always use the backup copy as 
your working disk, and store the original for safekeeping. For instruc­
tions, see Copying a Disk in Chapter 2.

To switch on your computer, follow these steps:
1. Insert the disk into the internal drive (drive A). Hold the disk by its 

plastic casing, label side up, with the metal sleeve towards the 
slot on the front of the disk drive. Slide the disk gently forward into 
the drive opening until it clicks and locks into position. When 
properly inserted, the disk will be completely inside the drive.

Note: The disk inserted in drive A when you switch on your com­
puter is called the boot disk. When you become more familiar with 
your computer, you may want to make your own custom boot disk.
See Making Your Own Boot Disks in Chapter 6 for information.



2. Switch on your monitor, your second disk drive (if you have 
one), then your computer. Always switch on your computer last. 
The power light on your keyboard comes on and the drive’s 
busy light illuminates as the disk whirs. The computer is 
retrieving information from the microfloppy disk. After a few 
moments, the first screen display appears:

Desk File View Options

This is the GEM desktop. It is the starting point for almost everything 
you do with your MEGA ST Computer. (The GEM desktop is dis­
cussed in detail in the following chapters.)

Note: If the GEM desktop does not appear on your screen, switch 
off the computer. Make sure your monitor is switched on, the disk is 
correctly inserted in drive A, and all cable connections are proper 
and secure. Try switching on the system again. If the GEM desktop 
still fails to appear, see Appendix B: Troubleshooting and Preven­
tive Maintenance.
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Switching Off the System
Before switching off your system, remove any disks in your drives 
by pressing the eject button firmly inward. Then, switch off system 
components in the reverse order that you switch them on. First 
switch off your computer, then your second disk drive (if you have 
one), then your monitor.

Wait at least ten seconds before switching your computer back on. 
Switching the computer off and then on again is called a coldstart, 
and it completely resets the computer.

Ports and Features
The Keyboard Unit
The MEGA ST Computer keyboard is similar to a conventional 
typewriter keyboard in both design and function. For example, the 
[Return] key on the computer keyboard acts like the carriage return 
lever (or key) on a typewriter: it is used to move the cursor down one 
line of type on the screen. In addition, many keys on the computer’s 
keyboard perform special functions not found in a typewriter.

Note: In this manual, characters enclosed by square brackets ([ ]) 
represent keys on your computer keyboard. Sometimes a procedure 
requires you to use two or three keys at the same time. In that case, 
the keys are listed in order. For example, [Control] [X] means to 
press and hold down the [Control] key and then press the [X] key.

Most keys will automatically repeat when they are held down. (For 
information on changing the rate of auto-repeat, see Control Panel

Function Keys
in Chapter 5.)

Calculator 
Keypad

Arrow Keys



The alphanumeric keys (letters, numbers and symbols) usually func­
tion just like similar keys on a typewriter. Pressing the [S] key pro­
duces the lowercase letter “s” and pressing [Shift] [S] produces 
the uppercase letter “S.”

The [Control], [Shift], and [Alternate] keys are most often used in 
conjunction with another key to produce a secondary function or 
code. You hold down one of these keys while pressing another 
key. For example, you might press [Control] [U] to turn on under­
lining in your word processor.

Along the top of the keyboard are the function keys [F1] through 
[F10], These keys have no set meaning and are often used by soft­
ware applications to perform special functions.

The four [Arrow] keys are generally used to move the cursor in 
the direction of their arrows, horizontally or vertically. The cursor 
is a movable graphic symbol, often an arrow, a block (|), or a 
vertical line < |), on the screen, that marks where the next action 
will take place.

The calculator keypad usually functions as an alternate method 
for entering numbers and math symbols, generally producing the 
same effect as typing the number or symbol from the typewriter 
keyboard. [Enter] usually acts as [Return],

Note: You can usually tell when the computer wants you to type 
something by the presence of a text cursor (generally a vertical 
line or a block).

The keyboard unit houses the mouse and joystick ports. The bottom 
of the keyboard includes adjustable legs so you can raise or lower 
the keyboard to its best typing position.
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Computer
The MEGA ST Computer connects to the keyboard through the 
computer jack.

Ct Mouse and Joystick
The mouse connects to the MEGA ST Computer keyboard through 
the mouse/joystick port 0. ATARI-compatible joysticks can also be 
connected through either port 0 or 1. You use joysticks when play­
ing computer games to control the action of the game on screen.

The Computer’s Back Panel
Many types of external devices, called peripherals, can be 
attached to the back panel of your MEGA ST Computer.

Floppy Disk

QG®@
A

Midi Out
Reset

Midi In

Monitor
Hard Disk

Fan
Vent

Modem

Printer

On/Off Power

Be sure to switch off the power to both the peripheral and the 
MEGA ST Computer before attaching anything to the various ports. 
Some peripheral cables have small retaining screws or clips on 
the sides of the connector. When the cable is in place on the 
computer, tightening the screws or attaching the clips maintains 
a strong connection and helps eliminate interference which might 
affect television or radio reception in the area.

Warning: Never touch the exposed contacts on any port. Static 
electricity could harm the sensitive electronics inside your MEGA 
ST Computer.



// Reset
The reset button restarts the computer without switching it off. 
Restarting the computer this way is known as a warmstart.

Fan
Your MEGA ST Computer is equipped with an internal fan. Vents 
for the fan are placed on the back panel and top of the computer. 
Never obstruct airflow through these vents.

I O On/Off
The on/off switch turns the computer on and off; I is on, O is off.

Modem
Any industry-standard RS232 modem may be connected to your 
computer through the modem port by connecting the modem’s inter­
face cable. Your computer uses a modem to transmit and receive 
information to and from other computers over telephone lines. With a 
modem in your system, you can hook into a variety of electronic 
information and mail services, communicate with the computer at 
work, or talk to a friend’s computer. You can also connect a serial 
printer or any other RS232 device through the modem port.

~ Power
The power jack connects the computer to the power source.

Printer
An ATARI Parallel Printer connects to your computer through the 
printer port. Connect the interface cable that came with your 
printer to this port, then to the printer. The printer port is an 
industry-standard parallel interface, so almost any parallel printer 
can be attached here.

«T 3 / ±1 Midi In/Out
MIDI stands for Musical Instrument Digital Interface. The two Midi 
ports give your computer access to electronic musical instruments. 
The Midi In port allows the computer to monitor a synthesizer or any 
other MIDI-equipped instrument. Through the Midi Out port, the 
computer controls an instrument’s digital interface, letting you play 
complex compositions while changing the volume, tempo, and 
instrumentation. Using the MIDI interfaces and appropriate applica­
tions software, your computer can become a sophisticated studio 
recorder which you can use to create music one track at a time.
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Monitor
An ATARI RGB Color Monitor or an ATARI High-Resolution Mono­
chrome Monitor attaches to your computer through the monitor jack.

Floppy Disk
A second floppy disk drive (drive B) can be connected to your 
MEGA ST Computer through the floppy disk port.

0 Hard Disk
An ATARI Hard Disk Drive attaches to your computer through the 
hard disk port. Connect the interface cable supplied with your 
hard disk to this port, then to the hard disk. A hard disk drive 
(drive C) can store much more information and transmit that infor­
mation much faster than a floppy disk drive.

The hard disk port is a DMA (Direct Memory Access) port, provid­
ing a high-speed entry point directly into your computer’s memory. 
You can also attach an ATARI Laser Printer or other high-speed 
peripheral to this port.

The Computer’s Left Side Panel
The left side panel of the MEGA ST Computer contains the key­
board jack and cartridge slot.

Cartridge Keyboard

Keyboard
The keyboard connects to the MEGA ST Computer through the 
keyboard jack.

Cartridge
Software programs for the MEGA ST Computer that come in car­
tridge form are inserted in the cartridge slot. Cartridge programs load 
instantly and do not tie up any of the computer’s memory. Up to 
131,072 bytes (128 kilobytes) of program information can be con­
tained on a single cartridge. The system treats the cartridge as 
drive c.



The Computer’s Top Panel
The top panel of the computer holds the battery housing for the 
computer’s real-time clock and two of the internal fan vents.

Battery Housing

Batteries
The batteries that run the MEGA ST Computer’s real-time clock are 
installed in the battery housing. Use two size AA batteries. Be sure 
to align the positive ( + ) and negative (-) ends of the batteries with 
the markings on the battery slots.

Warning: To prevent electrical shock, do not remove the cover 
from the MEGA ST Computer. Obtain all servicing, including 
expansion board installation, from an authorized ATARI dealer or 
service center. Before any expansion board installation is per­
formed, it is absolutely required that the AC power cord be 
removed from the MEGA ST Computer.
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CHAPTER 2
ST COMPUTER SYSTEM OVERVIEW

How the ST Computer Works
A computer uses integrated circuits to follow a set of instructions. 
Integrated circuits are small silicon wafers containing intercon­
nected electrical components. Part of the system of circuits forms 
the computer’s memory. The set of instructions, called a program, 
is contained in the computer’s memory.

Memory
The ST Computer relies on three types of memory to store programs 
and other data: ROM (Read Only Memory), RAM (Random Access 
Memory), and magnetic disks.

ROM is permanent memory in your computer. ROM stands for Read 
Only Memory, meaning your computer can read the information in it, 
but you cannot change this information, add to it, or erase from it. 
Information in ROM is built-in and remains intact whether or not the 
computer has power.

RAM is the computer's memory chalkboard, and contains no informa­
tion until you put it there. RAM stands for Random Access Memory, 
meaning you can choose which information in RAM to access, and 
you can change it, add to it, and erase from it. Information in RAM is 
not permanent; it vanishes when you switch off your computer.

Magnetic disks are separate from the computer. They store informa­
tion, which can be read from the disk into RAM and later saved back 
to the disk from RAM. Information on a disk can often be erased and 
the disk reused. (For complete information about disks, see Micro­
Floppy Disks later in this chapter.)

Memory is generally measured in bytes. A byte of memory holds 
about one typed character. A kilobyte is 1,024 bytes; a megabyte is 
1,024 kilobytes. The MEGA ST Computer has 192 kilobytes of ROM, 
and from one to four megabytes of RAM, depending on the model.
Magnetic disks for the ST Computer have either 357,376 bytes (single­
sided disks) or 726,016 bytes (double-sided disks) of memory capacity.
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TOS and GEM
TOS, The Operating System, is contained in ROM. TOS manages the 
way your ST Computer works, handling tasks such as reading and 
writing to disks, channeling commands from your mouse to the 
mouse pointer on screen, and displaying information on screen.

GEM, the Graphics Environment Manager, is part of TOS. GEM pro­
vides a graphic interface for the computer, so that information can 
be displayed on screen In graphic images (such as picture icons and 
windows) as well as in letters, numbers, and symbols.

The GEM Desktop
Whenever you switch on your ST Computer (as explained in Chapter 1), 
the first screen displayed is the GEM desktop. The GEM desktop is 
controlled by GEM, and is graphically designed to resemble an 
office, with file drawers, desktop working surface, and trash can. The 
standard elements on the desktop are the menu bar along the top of 
the screen, three icons along the left side, and the mouse pointer.

Disk Icons

Trash Icon

Mouse Pointer

Menu Bar
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The menu bar gives you access to the drop-down menus, which list 
system options available from the desktop. Each menu heading 
(Desk, File, View, and Options) has its own drop-down menu, from 
which you can select options. (Chapter 4 gives a complete descrip­
tion of the menu bar.)

Disk icons look like file drawers. They represent the disks (and the 
disk drives) which hold programs and data. The two disk icons that 
first appear are labeled “FLOPPY DISK” because they are used to 
access information on your microfloppy disks. The trash icon looks 
like a trash can, and is used to delete unwanted items from your 
disks. (For more information, see The Disk and Trash Icons in 
Chapter 3.)

The mouse pointer shows your position on the desktop. You control 
the mouse pointer either with the hand-held mouse or from the key­
board. When the computer is busy loading or transferring informa­
tion, the mouse pointer changes to a bee icon.

Controlling the Mouse Pointer
The mouse supplied with your ST Computer is your main device for 
controlling the mouse pointer. It is a small, rectangular box with two 
buttons on top, a roller underneath, and a cable connecting it to 
mouse/joystick port 0 on your computer keyboard.

The mouse is used by rolling it over a clean, hard, flat surface such 
as a tabletop. The ST Computer detects its motion (direction, dis­
tance, and speed) and moves the mouse pointer on screen in the 
same way. By moving the mouse, you can position the pointer where 
you want it on the desktop.
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Place the mouse on a flat surface near your computer with the cable 
pointing away from you. Now roll the mouse around in any direction. 
Notice how the mouse pointer moves on screen in the same direc­
tion the mouse moves.

Note: If you touch the menu bar with the mouse pointer and a menu 
drops down, you can retract it by moving the pointer out of the menu 
and pressing and releasing the left mouse button.

o T ' ■. ZZIZZZZ.. z
UERTICfiL MOUSE MOVEMENT

Pointer
Pointer

. kK Pointer

KO K HORIZONTAL MOUSE MOVEMENT
K
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Clicking the Mouse Buttons
Clicking is a mouse operation used to perform one action at a 
time, such as selecting a file, on the desktop. For most actions 
you will click the left mouse button. Double-clicking combines 
several actions, such as selecting and opening.a file.

To click, press and release the mouse button once. To double-click, 
quickly press and release the mouse button twice. (Double-clicking 
correctly takes some practice, and you may not master it on the 
first try.)

Clicking Double-Clicking

Note: To adjust the responsiveness of the mouse buttons to your 
clicking speed, see Control Panel in Chapter 5.

Selecting
When you select an item on the GEM desktop, you tell the computer 
you want to use the disk, file, or function that the item represents. To 
select an item, move the mouse pointer until its tip is on the item. 
Then click the left mouse button.
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Selecting an Icon
To select an icon, first point at it by positioning the tip of the mouse 
pointer on that icon.

Desk File View Op

Correct

Positioning the Mouse Pointer

Incorrect

Desk File View Op Desk File View Opt

Incorrect

When the pointer is correctly positioned, click the left mouse 
button. The icon will reverse shading (highlight) to indicate it has 
been selected.

To cancel your selection, move the pointer away from the icon and 
click the left mouse button. Selecting a different icon also cancels 
the first selection.

Canceling the Selection

Desk File View Options Desk File View Options

Selecting an Icon

Selecting a Menu Heading and Option
Each menu heading on the menu bar has its own drop-down menu. 
Move the mouse pointer onto the menu bar and point at one of the 
headings. Its menu immediately drops down.



Selecting a Menu Heading

Moving the pointer along the menu bar lets you examine each menu 
in turn. As you move the pointer from one heading to another, the 
previous menu retracts and the next menu drops down.

Once a menu drops down, its options are available for you to select. 
Move the mouse pointer down the menu over the options. Notice that 
the options highlight as you point to them. To select an option, click 
the left mouse button when the option is highlighted.

Inactive Option

Active Option

Selecting a Menu Option

A drop-down menu may have both active and inactive options. Active 
options are in black text and produce an action when selected. Inac­
tive options are in light grey text and produce no action if selected, 
other than causing the menu to retract. Some options have a check 
(V ) next to them, indicating they are currently selected.

To retract a menu without selecting an option, move the pointer out­
side the menu and click the left mouse button.



Dragging
Dragging moves items from one place to another on the desktop.

To drag an item, first point at it, then press and hold down the left 
mouse button. The item highlights, and a ghost outline of the item, 
appears. Still holding down-the mouse button, move the mouse 
pointer across the desktop. The ghost outline follows the pointer. 
When you release the button, the item jumps to its new location, 
appearing at the last position of the ghost outline.

Selected Icon

Ghost Outline

Desk rile View Options

Dragging an Icon

i
Mouse Pointer

Controlling the Mouse Pointer from the Keyboard
You can use certain keys on your ST Computer keyboard to move the 
mouse pointer around the desktop. The following list gives the key­
stroke combinations that control the mouse pointer. To use the com­
binations, hold down the first key listed and press the second key (or 
hold down the first two keys and press the third key).

[Alternate] [any Arrow key] Moves the pointer eight pixels (screen 
dots) in the direction of the arrow.

Alternate] [Shift] 
any Arrow key]

[Alternate] [Insert]

Moves the pointer one pixel in the direc­
tion of the arrow (for fine positioning).

Selects an item, in the same way as click­
ing the left mouse button. To double-click, 
hold down [Alternate] and quickly press 
[Insert] twice.
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Alternate] [Insert] 
any Arrow key]

[Alternate] [Clr Home]

Drags an item in the direction of the 
arrow, in the same way as holding down 
the left mouse button and moving the 
mouse.

Performs right mouse button functions.

Note: See Appendix A for a quick reference chart listing the key­
strokes for controlling the mouse pointer.

Dialog Boxes and Alert Messages
Dialog Boxes
When the ST Computer needs to communicate with you, it displays a 
dialog box in the center of the desktop. For example, in the dialog 
box below, the computer is asking you to name a new folder.

Enlarged Border

HEN FOLDER

Nane: I ._ _
I

— | OK | | Cancel

Dialog Buttons

To respond to a dialog box, type in the requested answer or per­
form the requested action. Then select one of the dialog buttons. If 
a dialog button has an enlarged border, it is the default button, and 
can also be selected by pressing [Return]. (A default is a value, 
option, or setting that the computer automatically makes unless 
you make another selection.) Pressing [Return] for the dialog box 
above selects the OK button.

Note: For a complete explanation of dialog boxes, see Editable 
Dialog Boxes in Chapter 6.



Alert Messages
The computer uses alert messages to bring something to your atten­
tion. Alert messages are punctuated with stop signs, question marks, 
or exclamation points, and may either caution you about an intended 
action or tell you something went wrong.

Dialog Buttons

Enlarged Border

When you see an alert message, follow its instructions, then select 
the appropriate dialog button. If a dialog button has an enlarged 
border, you can also select it by pressing [Return].

One-Drive and Two-Drive Systems
Your ST Computer includes a built-in floppy disk drive which may 
be single- or double-sided. In addition, your computer can connect 
to a second, external floppy disk drive, again either single- or 
double-sided. A single-sided drive uses only single-sided disks; a 
double-sided drive can use both single- and double-sided disks. 
(For a complete explanation, see MicroFloppy Disks later in this 
chapter.)

The built-in floppy disk drive is called drive A. However, the GEM 
desktop displays two floppy disk icons, A and B. in systems limited 
to one disk drive, that drive acts as both drive A and drive B. During 
operations that use two disks, such as copying a file, the computer 
will tell you with dialog boxes when to switch disks in the drive as the 
operation progresses:

You must switch disks when requested in order to proceed.
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If you have connected a second floppy disk drive to your system, 
your built-in drive remains drive A and the external drive becomes 
drive B. With two disk drives, you can operate with two disks at the 
same time.

Note: Installing a RAM disk program in a one-drive system lets you 
operate as if you had two disk drives. A RAM disk uses part of RAM 
as a disk drive, and eliminates the need to switch disks in the drive 
during certain procedures. For more information on RAM disk pro­
grams, contact your ATARI dealer.

MicroFloppy Disks
Microfloppy disks serve as permanent storage for your programs and 
the information you develop using your programs. These disks (often 
called floppy disks or floppies) consist of a 3!/2-inch rectangular 
plastic casing holding a circular sheet (disk) of oxide-coated material. 
This material is the magnetic media, which holds data and is read by 
the disk drive. Its accessible section is protected by a sliding 
metal sleeve. Most floppies also have a write-protect notch in the 
lower left corner.
Front of Disk

Write-Protect Notch

Insert a floppy disk into your disk drive, metal sleeve first, with the 
write-protect notch on the left. Inside the drive, a mechanical catch 
slides the metal sleeve open, exposing the sensitive magnetic disk to 
the drive’s read/write head. Information is written on the disk in 
concentric rings called tracks. The read/write head moves back and 
forth from one track to another as the disk spins.

Warning: DO NOT slide the metal sleeve open or touch the magnet­
ic disk. Doing so may damage your disk and the information on it.

Remove a floppy disk from your drive by firmly pressing the eject but­
ton on the front of the drive. Be sure the drive’s busy light is off before 
you insert or remove a disk.
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Single-Sided and Double-Sided Disks
Microfloppy disks can be either single-sided or double-sided and are 
usually marked as such. Both types of disks look the same. In a 
single-sided disk, only one side of the magnetic disk is certified as 
safe for storing information. In a double-sided disk, both sides of the 
disk are certified. A single-sided disk can store up to 357,376 bytes of 
information; a double-sided disk can store up to 726,016 bytes of 
information.

Write-Protecting a Disk
When you write-protect a disk, you prevent information from being 
written to the disk. To write to a disk means to store information on 
the magnetic media. (Similarly, to read a disk means to retrieve infor­
mation recorded on the disk.) The drive and computer work together 
to write information from the computer’s memory onto the disk, or to 
read information from the disk into the computer’s memory.

Most disks have a small write-protect notch in the lower left corner of 
their plastic casing. On the back of the disk, the write-protect notch 
has a sliding tab. To write-protect a disk, slide the tab until you can 
see through the notch.

Sack of Disk

Sliding Tab

A write-protected disk cannot be formatted, erased, or written to. It’s 
a good idea to write-protect disks containing important information 
so that you don’t inadvertently erase them, especially during copying 
with a one-drive system. You can move the write-protect tab back to 
the unprotected position at any time.

Note: Some commercial applications program disks do not have 
write-protect tabs. These disks are permanently write-protected.



Formatting a Disk
You must format a new disk before you can use it. Formatting pre­
pares a disk to receive information by completely erasing the disk, 
checking it for damage to the magnetic media, and setting patterns 
in place to hold the information you will eventually write to the disk.

Single-sided disks must be formatted as single-sided. However, you 
can format disks certified for double-sided use as either double- or 
single-sided. Disks formatted as single-sided can be used in both 
single- and double-sided drives. Disks formatted as double-sided can 
be used only in a double-sided drive.

You can also reformat disks you’ve already used. Since formatting 
erases all information on a disk, it’s sometimes more efficient to 
reformat a disk rather than delete all its files using the trash can.

To format a disk, follow the steps below.

Warning: Formatting a disk completely erases all information on the 
disk. Before formatting a disk, be sure to copy any data from it that 
you want to save (see Copying Files and Folders in Chapter 3).
1. Make sure the disk you want to format is not write-protected. 

Then, with your computer turned on and the GEM desktop dis­
played, insert the disk into drive A. (If you have a two-drive 
system, you can insert the disk into either drive A or drive B.)

2. Select the floppy disk A icon (or select the floppy disk B icon if 
you have inserted the disk into drive B).

3. Move the mouse pointer to the File heading in the menu bar. 
When the File menu appears, select the Format option.
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4. The GEM desktop now displays the following alert message:

Formatting will ERASE all 
the information on the disk 
in drive A:. Click on OK 
only if you don't mind 
losing this information.

OK | |Cancel |

As a safeguard, this message warns you that formatting will 
erase any information previously stored on the disk. If you are 
beginning with a blank disk, the warning doesn’t apply. Select 
the OK button and proceed to the FORMAT dialog box.

FORMAT _ _ _ _ _ _
EXIT

DRIVE ID: A: | FORMAT

DISK LABEL: I  
I

FORMAT:

Single Sided Double Sided

DRIVE ID shows which drive will begin formatting. The DISK LABEL 
line lets you name your disk, although it isn’t necessary to do this. 
(For information on naming your disk, see Filenames, Directories, 
and Pathnames in Chapter 3.) Select either the Single Sided or 
Double Sided button, depending on how you want to format 
your disk.

Reminder: You must have a double-sided disk in a double-sided 
drive to use the double-sided format option. Once you format a disk 
as double-sided, you can use it only in a double-sided drive. You may 
format a double-sided disk as single-sided, although only one side of 
the disk will then be used.



5. Select FORMAT (or select EXIT to stop the process and return to 
the desktop). When you select FORMAT, the drive begins format­
ting and the FORMAT WORKING box appears, monitoring the 
format process.

FORMAT

WORKING ...

6. When formatting is completed, the following alert message 
appears:

OK

This disk has 357376 bytes 
available to user.

Select the OK button (or press the [Return] key) to proceed.

Note: If your computer does not report that the formatted disk can 
hold 357,376 bytes of information for a single-sided disk or 726,016 
bytes of information for a double-sided disk, the disk may be defec­
tive. Try formatting it again. If the problem persists, discard the bad 
disk and use another disk.
7. The FORMAT box again appears. Select EXIT to return to the 

GEM desktop.



If you try to use a disk without first formatting it, or if you try to use a 
double-sided disk in a single-sided drive, the computer displays the 
following alert message:

V Drive A: is not responding. 
Please check the disk drive, 
and insert a disk. If it is 
a hard disk, check its 
connections. 

Cancel | | Retrg |

Insert a correctly formatted disk into the drive, then select Retry.
(Or select Cancel to tell your drive not to read that disk.)

Copying a Disk
It is essential to make a backup copy of all your important disks. This 
protects you from losing a disk or damaging its contents.

Note: It’s especially important to make a backup copy of the disk 
supplied with your ST Computer. Then store the original disk and use 
the backup copy as your working disk. If you haven’t already copied 
the disk, you should do it now. Be sure to write-protect the disk before 
you copy it.

In order to copy a disk, you need to have another formatted disk 
available as your destination disk. This disk need not be blank, but 
all data on it will be overwritten during copying. A destination disk 
must be the same type (single- or double-sided) as the original disk. 
(You cannot copy a double-sided disk to a single-sided disk or vice 
versa.)

To copy a disk, follow these steps:
1. Have two disks ready: the original disk (called the source disk), 

and a formatted disk (called the destination disk) to copy to. Make 
sure the source disk is write-protected, and the destination disk is 
not write-protected.

2. With your computer turned on and the desktop displayed, insert 
the source disk into drive A. If you have two disk drives, insert the 
destination disk into drive B (your external drive).



3. Drag the floppy disk A icon onto the floppy disk B icon. When 
the floppy disk B icon highlights, release the mouse button.

Desk File View Options

4. An alert message appears, warning you that copying disk A to 
disk B will erase all information on disk B.

Copying disk fi: to disk B: 
W Will ERASE all the 

infornation on disk B:. Click 
on OK only if you don't nind 
losing this infornation.

OK | [Cancel |

If you have two drives, make sure your source and destination 
disks are in the correct drives before proceeding. Then select 
the OK button. The DISKCOPY box appears.

diskcopy ______ _
| EXIT I

COPY
source drive: fi:
DESTINATION DRIVE: B:
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5. Select the COPY button to begin copying. If you have one disk 
drive, the computer prompts you (with dialog boxes) to switch 
disks from time to time as it copies sections of information. The 
DISKCOPY WORKING box monitors the copy process.

DISKCOPY

WORKING ...

SOURCE DRIVE

DESTINATION DRIVE — Progress Indicators

6. When copying is completed, the DISKCOPY box reappears. 
Select the EXIT button to return to the GEM desktop.

Note: If you have one double-sided disk drive and one single-sided 
disk drive, you cannot do a disk-to-disk copy using double-sided 
disks. To find out how to copy information from a double-sided disk to 
a single-sided disk, and vice versa, see Copying Files and Folders 
in Chapter 3.



CHAPTER 3
ICONS, WINDOWS, FILES,

ND FOLDERS
Icons, windows, files, and folders are four important elements of the 
GEM desktop. You select an icon in order to open a window or per­
form some other desktop operation. Windows list the files and folders 
on your disks. Files contain data or programs; folders contain groups 
of related files.

The Disk and Trash Icons
When you first switch on your ST Computer, the GEM desktop dis­
plays three icons: two disk icons, each labeled “FLOPPY DISK,” and 
the trash icon.

FLOPPY DISK

FLOPPY DISK

TRASH

The disk icons represent your microfloppy disks, and are labeled 
“A” and “B” to correspond with drive A and drive B. Disk icons look 
like file drawers because your disks and disk drives act like the 
computer’s filing cabinet, where you store and retrieve information 
when working with your ST Computer. You open the disk icons to 
use the items stored on your disks.

Note: For one-drive systems, your internal drive is both drive A 
and drive B. For two-drive systems, your internal drive is drive A 
and your second, external drive is drive B. For more information, 
see One-Drive and Two-Drive Systems in Chapter 2.
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The trash icon works like a real trash can. When you want to delete a 
file or folder from a disk, you can drag the item to the trash icon — in 
effect, throwing it away. A dialog box appears confirming your action, 
and when you select OK, the file is erased. (For more information on 
using the trash icon, see Deleting Files and Folders in this chapter.)

Warning: The trash icon actually works like an incinerator. Once 
you throw something away, it’s gone forever. You can’t retrieve it.

Windows
On the GEM desktop, most of the activity happens in areas called 
windows. Windows are small screens within the larger video screen 
display, and they show the files and folders contained on your disks. 
The GEM desktop lets you have up to four directory windows dis­
played on screen at one time.

Note: The windows shown in this manual are examples only. The 
contents of your windows may be different.

Opening a Window
You.must open a window in order to look at the items on a disk. Insert 
a formatted disk containing data into a drive. Next, select the disk 
icon for that drive. Then move the mouse pointer to the File menu, 
and select the Open option.

Opening a Window
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Another way to open a window is by double-clicking the left mouse 
button on the disk icon. Insert a disk into drive A, then double-click 
on disk icon A to open its window. When the window opens, you 
will see a directory of the disk's contents (or part of the directory if 
there are more items in the directory than will fit in the window).

Disk Identifier--------------------------------------------- --------------------

Information Line------ ►

Directory of Contents —

The disk identifier tells which disk you've opened by identifying the 
drive the disk is in. The information line gives the total number of 
bytes used by items listed in the directory, plus the number of items 
listed. (Bytes used by items contained in folders are not given in this 
line until you open the folder. To find out how many bytes are still 
free on the disk, see Show Info in Chapter 4.) The directory of 
contents shows an icon and name for each item in the main direc­
tory of the disk.

Note: You can display a window’s directory as text rather than as 
icons by selecting the Show as Text option from the View menu. 
See Show as Icons and Show as Text in Chapter 4.
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The Active Window
A window is active when its move bar is shaded and its scroll bars 
contain scroll arrows. The active window is the only one whose items 
you can select, delete, or copy. It is the only window you can move, 
scroll, update, or resize. You can open up to four directory windows 
at a time on the desktop, but only one of them will be active. You can 
make any window the active window by clicking the left mouse 
button anywhere on the window.

Scroll Arrow

Scroll Bar

Open windows may overlap like pieces of paper. If they do, the 
active window is always completely displayed. If an inactive 
window is partly hidden by another window, it will be completely 
redisplayed over the other windows when you make it active.
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Sizing a Window
You can change the size of an active window by using the size box 
in the lower right corner of the window. To size a window, drag the 
size box in the desired direction: move down to lengthen the win­
dow; up to shorten it; right to widen it; and left to narrow it. A 
ghost outline of the window follows the mouse pointer, indicating 
the window’s eventual size. Release the button to set the window 
in its new size.

Ghost Outline

Sizing windows lets you position more than one open window on 
the GEM desktop (for example, to copy files from one window to 

Size Box

ill!
. ............... «>***»««

Sizing a Window
Full Box

Desk File View Options

42341 bytes used in 7 itens.

another).

To quickly enlarge a window to fill the entire screen, select the full 
box in the upper right corner of the window. Selecting the full box 
again returns the window to its previous size and shape.



Moving a Window
You can move a window to any position on the desktop (except over 
the menu bar) by using the move bar (the shaded bar along the top of 
the window). To move a window, select the move bar and drag it to 
another location on the desktop. A ghost outline of the window fol­
lows the mouse pointer. When you release the mouse button, the 
window pops into its new position.

Move Bar

Ghost Outline

ionsDesk File View

Moving a Window

Moving windows lets you position more than one open window on 
the desktop (for example, when you want to compare the direc­
tories of two disks).



Scrolling a Window
Sometimes a window contains more items than it can show at once. 
One way to look at all the items in a window’s directory is to scroll the 
window. The scroll bars along the bottom and right edges of the 
window let you scroll the window horizontally (right and left) or 
vertically (up and down) along its directory.

Scroll Bar

A portion of the scroll bar will be shaded when items are hidden, 
and the scroll box will show the current position of the window 
relative to its total directory. For example, if the scroll box is in the 
middle of the scroll bar, then the window is displaying the items in 
the middle of the directory. The size of the scroll box, compared to 
the shaded area of the scroll bar, corresponds to the portion of the 
total directory currently in the window.

You can scroll a window by one unit (either one icon or one window 
display) at a time. To scroll by one icon at a time, select the scroll 
arrow indicating the direction of the hidden contents. To scroll by 
one window display at a time, select the shaded area of the scroll 
bar. To scroll continuously, press and hold down the left mouse 
button either on a scroll arrow or on the shaded area of the scroll bar.

You can quickly scroll a window by dragging the scroll box to a new 
position in the scroll bar. The window will now display the contents of 
that portion of its directory.

Note: Directory windows displayed as text cannot be scrolled hori­
zontally. (See Show as Icons and Show as Text in Chapter 4.)
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Updating a Window Directory
Updating a window directory is a way to make sure the window is 
displaying the actual items on the disk. For instance, if you open 
disk A’s window, and then insert a different disk into drive A, the 
directory in the window will not automatically show the items on 
the new disk. To update a window’s directory, first activate the 
window, then press [Esc].

Note: If you open a folder, and then insert a different disk in the 
drive, you must close the folder before you can update the 
window. To close a folder, select the close box in the upper left 
corner of the window. For more information, see Close and Close 
Window in Chapter 4.

Closing a Window
To close the active window, select the close box in the window’s 
upper left corner. The window will disappear from the screen. If 
another window is open, it will become the active window. (If more 
than one window is still open, the last window opened will become 
the active window.)

Closing a Window

Close Box

You can also close an active window by moving the pointer to the 
File heading in the menu bar, then selecting the Close Window 
option. (For more information, see Close and Close Window in 
Chapter 4.)



Files
Types of Files
The ST Computer stores two types of files on disk: program files and 
data files. On the GEM desktop, the two types of files are repre­
sented by different icons.

Program File Icon
GAME . PEG

Data File Icon

i jft A F' H I L i .OAT

The icon that looks like a small desktop is the program file icon, 
representing an applications program that you can run. That is, the 
program is executable. An example of an applications program is 
a word processor.

The icon that looks like a stack of paper with one corner folded over 
is the data file icon. Data files contain the data used by applications 
programs, such as the text you use with your word processor.

You will have as many file icons in your directory as you have files on 
your disk. Each icon will have a different filename listed under it.

Program Files Data Files
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Folders
Folders are part of your filing system, providing you with a way to 
keep related files together. Folders have their own icon, which looks 
like a manila folder.

Folder Icon

Folders hold data and program files, and other folders. If you have 
a number of related files, you can place them inside one folder to 
keep them together. You can also put folders and files within other 
folders. The operating system, TOS, allows up to eight levels of 
folders within folders.

To create a folder, first activate the window for the disk you want. 
Then select the New Folder option from the File menu. The following 
dialog box appears:

HEN FOLDER

Nane: L _ _ _ ■_
1

OK Cancel

Type in a name for the folder and select the OK button (or press 
[Return]). Like filenames, folder names can have from one to eight 
characters, optionally followed by a period (.) and a three-character 
extender. (However, unlike files, folders cannot be renamed from the 
GEM desktop.) The new folder is created on your disk and the active 
window is updated to list it in the directory.

Warning: Never have more than 40 folders total at one time on all 
drives (including a hard disk, if connected).

Opening a Folder
Every folder can be opened to its own window so that you can view 
the items it contains. To open a folder, either double-click the left 
mouse button on the folder’s icon or select the folder icon, then 
select the Open option from the File menu.
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Opening a Folder

When a folder opens, the folder directory replaces the disk direc­
tory in the window, and the name of the folder is appended to the 
disk identifier. Once a folder is opened, the files (and other folders) 
it contains can be accessed.

Sample Open Folder

iooO f1:\TAXES\ V a

17763 bytes used in 3

1 3‘
__p
::c f =lX 13

,___ n

. TF

0

0
0 0 E

A newly created folder will be empty. Information on how to copy files 
into folders is given in the next section, Managing Files and Folders.



Managing Files and Folders
Copying Files and Folders
On the GEM desktop, you can copy files and folders onto another 
disk or into a folder. When you copy a file, you copy a single item. 
When you copy a folder, all its contents (files and other folders) 
are copied to the new position.

To copy an item, select the item and drag it to its new position on the 
desktop. You can drag an item to another window, disk icon, or folder 
icon. (If you drag the item to a disk or folder icon, the icon highlights 
when the mouse pointer is positioned on it correctly.)

Desk File View Options

Copying a File from One Window to Another

Copying a File into a Folder

42341 bytes used in 7 itens.



Copying a File to a Disk

OptionsDesk View

42341 bytes used in 7 itens

GAME.PEG

When you drag an item to a new position and release the mouse 
button, a dialog box appears:

COPY FOLDERS / ITEMS

Folders to Copy:  0
Itens to Copy:  1

| OK | | Cancel

Select OK to continue the copy procedure (or select Cancel to stop 
it). With one-drive systems, the computer will tell you (with dialog 
boxes) when to switch disks in order to complete the copy 
procedure.

Note: If the dialog box does not appear, the Confirm Copies option 
has been turned off. See Set Preferences in Chapter 4 for more 
information.
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Selecting Multiple Items
Sometimes you will want to copy or delete more than one item at 
a time. There are two ways to do this: by using the rubber-band 
box or by shift-clicking.

Selecting with the Rubber-Band Box
The rubber-band box lets you select a group of items that are in 
sequence on the desktop. Position the mouse pointer to the left of 
(nearby but not touching) the first item you want to select. Press 
and hold down the left mouse button, then drag the pointer down 
and to the right, across all desired items. As you drag the pointer, 
a lasso-like box will form around the items. Release the mouse 
button. Every item inside the box will be selected.

Press and Hold Here

Positioning the Pointer

Dragging the Pointer

Rubber-Band Box Drag to Here
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Once the items are selected, position the pointer on one of them, 
then drag it to another window or icon, or to the trash can. Ghost 
outlines of all selected items will appear, and will be dragged 
along with the pointer.

Desk File View Options

Dragging a Group of Selected Items

When you release the mouse button, all items will be copied to the 
new spot, or deleted, depending on where they were dragged.
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Selecting by Shift-Clicking
Shift-clicking lets you select a group of items that are not in sequence 
on the desktop. Press and hold down the [Shift] key, then select the 
first item. When the item highlights, move the mouse pointer to the 
next item and select it. When all items are selected, release the 
[Shift] key. Then move the mouse pointer to one of the selected 
items and drag it to its destination. Ghost outlines of all selected 
items will follow the pointer, and will be copied or deleted, depending 
on where they are dragged.
Selecting and Dragging Multiple Items by Shift-Clicking

Options

103658 bytes used in 6 itens.
$

BOOK.TXT

0

TRASH

CAMF'J CLOCK.FRG GAME .FRG

Desk File View

Note: You can combine the two methods, rubber-banding and shift­
clicking, to select a group of items, then deselect any items in the 
group that you don’t want to copy or delete. First use the rubber-band 
box to select a group. Before dragging the group, go through the 
items and shift-click on those items you want to omit from the group. 
Shift-clicking on items already selected will deselect them. (To rese­
lect an item, shift-click on it again.) Then drag the group to a window, 
icon, or the trash can to copy or delete.



Filenames, Directories, and Pathnames
Filenames are the names given to files, either by you or by the 
software developer. Directories are the lists of files and folders 
that appear in a directory window. Pathnames identify the disk and 
folders that were opened to reveal a directory.

Filenames
A filename is made up of two distinct parts: the name and the 
extender.

SAMPLE.PRG

extender (optional; up to three characters)

name (mandatory; up to eight characters)

A file must have a name in order to be listed and identified. A 
name can have from one to eight characters (letters or numbers) 
and may include the underline symbol ( ). Names usually are 
clues to the specific information in the file, such as TAXES for tax 
information, or TAXES85, TAXES86, TAXES87 for a series of tax 
information files.

An extender is optional and can have from one to three characters 
(letters or numbers). A period (.) always divides it from the name. An 
extender often indicates the type of a file. For example, the .PRG 
extender indicates to TOS that the file is a GEM application and that 
it should be represented by the program file (small desktop) icon. If 
you were to remove the extender (by using the Show Info option in 
the File menu), TOS would not recognize the file as an application 
and would give it the data file icon.

Many applications use specific extenders to represent specific 
types of data files. For example, word processors often use .DOC 
as an extender for document files.

When you sort files by type, they are arranged alphabetically by 
their extenders (see Sort by Name, Date, Size, and Type in 
Chapter 4).



Four common extenders and their meanings are listed below:
.APP GEM application
.PRG GEM application
.TOS TOS application
.TTP TOS-takes parameters application

These extenders indicate the three types of program files (files that 
can be run from the desktop). Program files are represented by the 
small desktop icon and are run by double-clicking on the icon (or 
selecting the icon and selecting Open from the File menu).

An .APP or .PRG file is a GEM application and will usually take 
advantage of the GEM environment by using windows, icons, and 
drop-down menus. A .TOS file is a non-GEM application. It does 
not use the GEM environment and may not even use the mouse. A 
.TTP file is a .TOS file that expects some typed parameters (data 
that will control the program’s operation). When you open a .TTP 
file, a dialog box appears requesting you to enter the parameters. 
Consult the program’s documentation for more information.

OPEN APPLICATION

Nane: UTILITY .TTP 
araneters:

| OK | | Cancel

Note: You can install an application as a different type than its 
extender indicates it to be. For information, see Installing an 
Application in Chapter 6.

Folder Names
Folder names follow the same naming constraints as filenames; 
however, extenders on folder names have no significant meaning 
to TOS.



Directories and Pathnames
A newly formatted disk has one directory, called the root (or main) 
directory. The root directory is the first directory you see when you 
open a disk icon. It is identified by the disk identifier (A: \ for the 
disk in drive A, and B: \ for the disk in drive B) in the move bar of 
the window. The disk identifier below shows the root directory of a 
disk in drive A.
Root Directory

A:\
9421 bytes used in 4 itens.

_______  L,___ [z|| Mil _ _ _
LETTERS DESKTOP'. I NF HELF'. TXT HOROF'ROC . F'RG

0

0 0 E

Disk Identifier

If you now open a folder named LETTERS from the disk in drive A, 
you enter a subdirectory:

Subdirectory Within a Root Directory

Disk Identifier ------------------------------ \ /-----------------------------Folder Name

© R:\LETTERS\ V A

4930 bytes used in 2 itens.

______ l—n
MOTHER MI KE. LET

0

0 0 E

A subdirectory is a directory residing within another directory. A 
folder is a subdirectory within the root directory, and a folder within a 
folder is a subdirectory within a subdirectory. When you open the 
folder named LETTERS, the name of the folder is appended to the 
disk identifier. A disk identifier and folder name listed together are 
called a pathname.



Pathnames are of the form: 

drive: \ folder \

where drive: \ is the disk identifier for the root directory and folder \ 
specifies a subdirectory. Each component of the pathname is sepa­
rated by a backslash (\). The pathname for the subdirectory of the 
folder named LETTERS is A: \ LETTERS \ . The pathname tells TOS 
which path to take to get to a particular file.

If you now open a folder named MOTHER within the folder named 
LETTERS, you enter another subdirectory. Notice how the pathname 
changes to reflect this:
Subdirectory Within a Subdirectory

A:\LETTERS\MOTHER\ V a

3120 bytes used in 2 itens.
1,___ [/|

MOM 1 . LET HOME . LET

0

0 0 E

A chart of the hierarchy of the disk looks like this:

MicroFloppy Disk □

Items in
Root Directory A:\

Items in
Subdirectory A:\LETTERS\

HORDF ROC . F RG

MOTHER M I ► E . LET

Items in
Subdirectory A:\LETTERS\MOTHER\

For more information on pathnames, see Using the Item Selector 
in Chapter 6.



riCHAPTER 4
THE MENU BAR
The menu bar is located along the top edge of the GEM desktop. The 
menu headings are Desk, File, View, and Options. To see the options 
within any menu, point at the menu heading with the mouse pointer. 
The heading highlights and the menu automatically drops down.

You can now select a menu option. Options in black text are active; 
they are available for use. Options in light grey text are inactive; they 
are not available for use at the time you drop down the menu. If an 
item is inactive, you may have to select an icon on the desktop in 
order to activate it. (See the specific option in this chapter for more 
information.)

Desk
The Desk menu contains the desk accessories. (Desk accessory 
files must be on the disk in drive A when you switch on your com­
puter. They always have the extender .ACC.) The menu may also con­
tain information about the application you are currently running.

You can access desk accessories from this menu at almost any time, 
provided you are using the GEM desktop or another application that 
uses the GEM menu bar. Depending on the desk accessories you 
loaded, you will have different options available under this heading. 
The standard set of desk accessories includes the Control Panel and 
the VT®52 Emulator. (For more information on those desk acces­
sories, see Chapter 5.)
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If you switch on your computer without using a disk, or with a disk 
in drive A that does not have desk accessories on it, the Desk menu 
will contain only one item, Desktop Info.

Switching on the computer without desk accessories frees some of 
the computer’s memory and displays the GEM desktop faster. How­
ever, if you want to use the desk accessories later, you will have to 
restart your system.

Desktop Info
The Desktop Info option is the billboard for the desktop, displaying 
GEM and TOS copyright information. Most GEM applications will 
display this kind of identifying information in an option under the 
leftmost menu heading (usually Desk) on the menu bar.

Select Desktop Info. The following dialog box appears:

GEM, Graphics Environnent Manager

A
ATARI

Copyright (c) 1386, 1987 
Atari Corporation 

Digital Research, Inc.
All Rights Reserved.

| OK |

Select the OK button to return to the GEM desktop.
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File
The File menu contains options that enable you to manipulate your 
files, manage your windows, create folders, and format disks.

Open
The Open option is used to open a disk icon or a folder, run an appli­
cation, or show or print the contents of a data file. To open an item, 
select the item, then select the Open option from the File menu. You 
must first select an item to open in order for this option to be active.

An alternative to using the Open option is to double-click the left 
mouse button on an item. Doing this selects and opens (or runs) 
the item in one operation.

Show Info
When you select a disk, file, or folder icon and then select the Show 
Info option, the screen displays information about the selected icon. 
Dates and times listed in Show Info dialog boxes are determined by 
the clock/calendar set from the Control Panel.

The Show Info dialog box for a disk icon looks like this:

DISK INFORMATION

Drive Identifier: 
Disk Label: 

Nunber of Folders: 
Nunber of Items: 

Bytes Used: 
Bytes Available:

B:
SAMPLE .DSK

__ _ 0
_ _ _ 4

—165432
— 189440

1 OK I



Note: In the Show Info dialog box for a disk, the number of bytes 
used plus the number of bytes available does not always equal the 
exact storage capacity of the disk. This is because the ST Computer 
allocates space for each file in fixed-size blocks, even if the file does 
not completely fill the last block. Show Info’s Bytes Available informa­
tion is your best monitor of available disk storage space.

The Show Info dialog box for a file identifies the file and gives its 
size, date and time last modified, and the Read/Write or Read-Only 
attribute.

ITEM INFORMATION

Nane: CASH , STH|
Size in bytes: 1846
Last nodi tied: 04/15/87 07:13 pn

Read/Nrite

Read-Only

| OK | | Cancel

You can rename a file within the Show Info dialog box. First make 
sure the file is set to Read/Write (see the following paragraphs). 
Then press [Backspace] or [Esc] to delete the filename, type a new 
name, and select the OK button (or press [Return]). The file will be 
renamed and the new filename will appear in the disk directory.

The Read/Write and Read-Only buttons indicate the file’s attribute. 
Read/Write is the normal option; when selected, it allows you to 
modify or delete the file. Read-Only works like a write-protect tab 
for individual files; when selected, it protects files from accidental 
modification. Select either attribute, then select OK (or press 
[Return]).

When a file is set to Read-Only, you cannot change, rename, or 
delete it. If you try, the following alert message appears:

fin iten with this nane 
already exists in the 
directory, or this iten 
is set to Read-only status,

| OK
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To modify the file, change its attribute back to Read/Write.

The Show Info dialog box for a folder gives the folder’s name, the 
date and time it was created, the number of folders and items held 
in the folder, and the folder’s size in bytes.

FOLDER INFORMATION

Folder Nane: MEMOS
Created: 03-16-87 10:13 an

Nunber of Folders: 2
Nunber of Itens: 19

Bytes Used: 36717

OK |

Note: You cannot rename a folder within the Show Info dialog box.

New Folder
Folders are organized collections of files. They are not files, but 
they can hold related program and data files in order to separate 
them from the larger group of all files.

To create a folder, open a directory window, then point at the File 
heading on the menu bar and select the New Folder option. The 
following dialog box appears:

NEU FOLDER

Nane: I ,_ _I
OK | | Cancel

Type in a name for the folder, then select OK (or press the [Return] 
key). The new folder will appear in the directory window. If you 
decide not to create a folder, select Cancel.

Once you create a folder, you can create other folders within it. Fold­
ers can be nested within folders down to eight levels. (For more infor­
mation, see Folders in Chapter 3.)
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Close and Close Window
The Close and Close Window options let you close a window on the 
desktop. Make sure the window is active, then select either option 
from the File menu. (You can also close a window by selecting the 
close box in the window’s upper left corner.)

The Close option and the close box work the same way: they both 
close the current directory window. When you are displaying a folder 
directory, that directory closes and the directory the folder is in is dis­
played in the window. When you are displaying a disk directory, that 
directory closes and the window disappears.

The Close Window option closes a window completely and takes it off 
the screen in one step, even if you are displaying a folder directory.

Format
Formatting is the process of preparing a microfloppy disk to accept 
data. Disks can be formatted as either single- or double-sided, and 
used disks can be reformatted. (For a complete explanation of for­
matting, see Formatting a Disk in Chapter 2.)

To format a disk, insert the disk into a drive, select the disk icon for 
that drive, then select the Format option from the File menu. A dialog 
box appears reminding you that formatting will erase all data on the 
disk. If you still want to format the disk, select OK. The following 
dialog box appears:

format ,
EXIT

DRIVE ID: B: | FORMAT

DISK LABEL: I
I

FORMAT:

Single Sided Double Sided

The Format dialog box gives you the option of labeling your disk. 
Labeling is a way to identify the disk; the label you give it will 
appear in the Show Info dialog box for that disk. Once labeled, a 
disk cannot be renamed until it is reformatted. To label a disk, type 
in the name from the keyboard, using the [Backspace] key to 
delete any errors.
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Note: Labeling a disk is optional; it isn’t a necessary step to for­
matting the disk.

Select either the single- or the double-sided option, then select the 
Format button. A Format Working box lets you monitor the operation. 
When the process is complete, a dialog box displays the number of 
bytes available for storage on the disk. Select OK, then select Exit 
from the Format dialog box that again appears.

If your disk doesn’t show 357,376 (single-sided) or 726,016 (double­
sided) bytes available, the disk may be defective. Try formatting 
again. If the problem persists, discard the disk.

Warning: When you reformat a used disk, any data on the disk is 
lost—forever. Be sure to copy the items you want to save before 
reformatting the disk.

View
The View menu lets you choose whether to display your files as icons 
or text, as well as whether to sort them by name, date, size, or file 
type. To modify how files are displayed, select the menu option you 
want. A check next to an option indicates that option is selected.

Options selected from the View menu affect all directory windows. 
You cannot select certain options for one window and alternate 
options for another window.

Note: Choices made using the View menu can be saved, so that 
when you switch on your computer, those choices are selected. See 
Save Desktop later in this chapter for instructions. Also see 
Customizing Your Desktop in Chapter 6.
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Show as Icons and Show as Text
The same directory displayed both as icons and as text is shown 
below:

Shown as Text

Folder Symbol

Filename

A

0 0

42341 bytes used in 7 itens.
TAXES 03-11-87 11:59 an -
NORDPROC 03-11-87 11:48 an
GAME PRG 464 03-11-87 11:47 an
GRAPHICS DAT 512 03-11-87 11:47 an
MESSAGE TXT 3453 03-11-87 11:47 an
TESTFILE TOS 35712 03-11-87 11:47 an
UTILITY TTP 2194 03-11-87 11:47 an

Date and Time 
Last Modified

File Size in Bytes

When a directory is shown as icons, different pictures (icons) in the 
window indicate different types of items. Items shown as icons are 
listed horizontally, left to right across the window. (See Chapters for 
a complete explanation of icons.)

When a directory is displayed as text, the window shows the file­
name, file size, and the date and time the file was last modified. A 
small box next to a filename is the folder symbol, and indicates 
that item is a folder. Items shown as text are listed vertically from 
top to bottom.

Files and folders displayed as text may be opened, copied, and 
deleted using the same techniques as for icons.
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Sort by Name, Date, Size, and Type
These options-determine how items in a directory window are 
sorted. Only one option at a time can be selected.

When Sort by Name is selected, items are listed in alphabetical 
order, folders before files.

Sort by Date lists items chronologically, with the most recently created 
or revised item appearing first. (Items are dated according to the clock/ 
calendar in the Control Panel. See Clock/Calendar in Chapter 5.)

When Sort by Size is selected, items are listed according to their 
size in bytes, with the largest item appearing first.

Sort by Type sorts items alphabetically by their extenders. Items 
with common extenders are grouped together in alphabetical order 
by name.

The two directories that follow are for the same disk. One direc­
tory sorts items by name; the other directory sorts by date.

Sorted by Name

>5 ' A: \ " V A

162284 bytes used in 8 itens.
W PRINTER 09-18-86 03:53 pn

ASCII HEX 7250 03-05-87 08:46 pn
ATARI TOS 138944 -11-20-85 02:36 an
BASIC RSC 4648 11-20-85 02:37 an
MENU+ DOC 5662 11-20-85 12:01 an
MENUDR DOC 5680 09-18-86 04:09 pn
SUPRGAME PRO 50 10-18-87 10:35 an
TEST BAS 50 09-19-86 10:05 an

0

0
<J 0 E

Sorted by Date

© A:\ ;; A

162284 bytes used in 8 itens._ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _
S PRINTER 09-18-86 03:53 pn

SUPRGAME PRO 50 10-18-87 10:35 an
ASCII HEX 7250 03-05-87 08:46 pn
TEST BAS 50 09-13-86 10:05 an
MENUDR DOC 5680 03-18-86 04:03 pn
BASIC RSC 4648 11-20-85 02:37 an
ATARI TOS 138344 11-20-85 02:36 an
MENU+ DOC 5662 11-20-85 12:01 an

0 O E



Options
The Options menu includes a variety of useful desktop features.

Desk File View Options

Note: Any choices you make with the Options menu can be saved 
to disk. See Save Desktop later in this chapter and Customizing 
Your Desktop in Chapter 6.

Install Disk Drive
When you switch on your ST Computer, the GEM desktop displays 
two disk icons. Each icon has a disk identifier (A or B) and the icon 
label ‘‘FLOPPY DISK.” You can change the icon label, remove a disk 
icon from the desktop, or re-install it with the Install Disk Drive 
option.

Select a disk icon, then select the Install Disk Drive option. The 
following dialog box appears:

INSTALL DISK DRIVE

Drive Identifier: A 
Icon Label: FLOPPY DISK.

Install | | Renove | | Cancel

To install a new disk icon, use [Backspace] or [Esc] to erase the 
current disk identifier, then type in the disk identifier of the icon 
you want to install. The two identifiers “A” and “B” represent your 
floppy disk drives. The uppercase letter “C” represents a hard disk; 
lowercase “c” represents a cartridge.

Note: The disk identifier is the same as the drive identifier.
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To change a disk icon’s label, select the Icon Label line; the vertical 
cursor jumps to that line. Press the [Left Arrow] key to move the 
vertical cursor, or press [Backspace] or [Esc] to erase the label. 
Type in a new name, using up to 12 characters. Finally, select the 
Install button. The new disk drive or label change will appear on the 
desktop.

To remove a disk icon, select the Remove button from the Install 
Disk Drive dialog box.

Warning: Never remove all disk icons from your desktop.

To re-install a disk icon you’ve removed, select a remaining disk 
icon on the desktop, choose Install Disk Drive, then type in the 
disk identifier of the missing icon. Select the Install button.

Install Application
Install Application lets you open a data file directly from the desk­
top into an application without having to open the application first. 
For instance, if you install a word processor with this option, you 
can then double-click the left mouse button on a text file listed on 
the desktop. The computer will load the word processor first and 
then load the text file, ready for you to work on.

To use the Install Application option, first select an applications 
program from a directory on the desktop. Then select Install Appli­
cation from the Options menu. The following dialog box appears:

INSTALL APPLICATION

Application Nane: WORDPROC.PRO 
Docunent Type: I

Application Type:

mil | TOS | | TOS-takes paraneters

OK | | Cancel |

The name of the application you selected appears on the Application 
Name line. On the Document Type line, type the common extender of 
the files that use that application.



Select GEM if the application you are installing has a .PRG or .APP 
extender; select TOS if the application has a .TOS extender; select 
TOS-takes parameters if the application has a .TTP extender.

Finally, select the OK button to install the application.

In order to use the installed application, a data file must have the 
same extender as you indicated on the Document Type line. (If the 
data file’s extender is different, select the file and use Show Info in 
the File menu to change the extender.) Also, the application file 
must be present, either on the same disk as the data files (prefera­
bly in the same folder but never in a different folder), or on the disk in 
drive A.

Note: For a detailed explanation of installing an application, see 
Installing an Application in Chapter 6.

Set Preferences
The Set Preferences option lets you choose whether or not to dis­
play certain dialog boxes, and what resolution your monitor display 
will be in.

When you select the Set Preferences option, the following dialog 
box appears:

SET PREFERENCES

Confirn Deletes:

Confirn Copies:

Set Screen Resolution:
High

| OK | Cancel

The Confirm Deletes and Confirm Copies options determine whether 
or not the computer displays a confirming dialog box before deleting 
an item or copying it. It’s a good idea to retain the Yes choice with 
these options. If you don’t want to confirm your copy or delete 
requests, select No in one or both of these lines. (To review how the 
confirming dialog boxes work, see Copying Files and Folders and
Deleting Files and Folders in Chapters.)
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The Set Screen Resolution option lets you select the resolution of 
your monitor screen display. If you’re using an ATARI Monochrome 
Monitor, you can select only High. If you’re using an ATARI RGB 
Color Monitor, you can select either Medium or Low. (Some color 
applications will require a specific resolution; refer to the applica­
tion's manual for information.)

Select the OK button (or press [Return]) to set your preferences. 
Select Cancel to exit the dialog box without changing your preferences.

Changing screen resolution has the same effect as pressing the reset 
button: it causes the computer to do a warmstart. Because of this, 
changing confirmation preferences and changing resolutions cannot 
be done at the same time. First change the resolution. Then reselect 
the Set Preferences option and change the confirmation preference.

Also because of the warmstart effect, you must have your desk 
accessories on a disk in drive A in order to retain them when you 
change resolution.

Save Desktop
The Save Desktop option lets you save any modification you make 
to the GEM desktop, such as the size and location of windows, the 
placement of icons, the way your files are displayed and sorted, 
and whether you’ve installed any applications. Once a modified 
desktop is saved, it will appear on screen every time you switch 
on your computer, as long as the disk you saved the desktop to is 
in drive A.

To use the option, first set up your desktop the way you want it.
(For more information, see Customizing Your Desktop in Chapter 6.) 
Make sure you have a disk in drive A, then select the Save Desktop 
option. A dialog box appears:

| OK | |Cancel
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Select OK to save your desktop. The ST Computer creates a file 
called DESKTOP.INF with your desktop information in it, and writes 
it to the disk in drive A.

From now on, whenever you switch on your computer with the 
DESKTOP.INF file on the disk in drive A, the system reads the file 
and sets up the desktop as you have modified it.

Note: If you are using a hard disk, the computer writes the DESK­
TOP.INF file to the main directory of that disk. When you switch on 
the computer, it checks the disk in drive A first for a DESKTOP.INF 
file. If it doesn’t find one there, it reads the DESKTOP.INF file on your 
hard disk.

Print Screen
The Print Screen option prints the current screen display on a printer. 
Everything on screen is printed (except the dropped-down Options 
menu).

To use the option, you must have a graphics printer connected to 
your computer, installed from the Control Panel, and switched on. 
Set up the screen you want to print, then select the Print Screen 
option. A dialog box appears:

Print screen display ?

Cancel

Selecting OK prints the screen; selecting Cancel stops the process.

Once printing is underway, you can stop it at any time by pressing 
[Alternate] [Help].

You can also print a screen by setting up your screen (moving 
the mouse pointer out of the way, if you want) and then pressing 
[Alternate] [Help]. Press [Alternate] [Help] again to stop printing 
at any time.

Note: If you try to print a screen without first turning on your 
printer, the system will try to access the printer for approximately 
30 seconds before giving up. This is known as timing-out.
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Blitter
The Blitter chip is a special processing circuit inside your ST Com­
puter that can greatly improve the speed of text and graphics. This 
chip can be turned on or off by selecting the Blitter option from 
the Options menu. When there is a check next to this option, the 
Blitter is enabled; when there is no check, the Blitter is disabled.

In most cases, you will want to have the Blitter on because faster 
graphics and text are desirable. However, some applications may 
run too fast (or not at all) with the Blitter enabled. In these cases, 
turn off the Blitter before executing the program.

Note: If your Options menu does not list the Blitter option, your 
ST Computer does not contain a Blitter chip.
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CHAPTER 5 
DESK ACCESSORIES
Desk accessories are special applications which are loaded into 
memory when you switch on your computer. A desk accessory 
can be anything from a clock to a calculator to the Control Panel 
and VT52 Terminal Emulator.

The disk supplied with your ST Computer has two desk accessory 
files on it: CONTROL.ACC and EMULATOR.ACC.

*r A:\ It: A

22654 bytes used in 2 itens.
L 0

1_ 7 7
CONTROL.ACC EMU LATOR.ACC

0 0

CONTROL.ACC is the Control Panel from which you can do things 
such as set your internal clock and modify the colors of your desktop. 
EMULATOR.ACC is the VT52 Emulator, a telecommunications terminal 
program. When a modem is connected to your ST Computer, this 
program lets your computer communicate with other computers.

Desk accessories are unique because you can run them at the same 
time you’re running another application (as long as the application 
uses the menu bar). For instance, if you’re using a word processor 
and you want to change how fast the keyboard responds to your 
typing touch, you can use the Control Panel desk accessory without 
exiting the word processor.

When selected, desk accessories open into dialog boxes or into win­
dows similar to directory windows. To use an accessory’s dialog box, 
select a dialog button or press a key on the keyboard, depending on 
the accessory. Use accessory windows as you use directory windows. 
For instance, the Control Panel window is activated by clicking the left 
mouse button on it, and includes a move bar and close box. Some­
times a desk accessory window is entirely covered by a directory 
window. To see the desk accessory window, move or size the direc­
tory window, or select the accessory again from the Desk menu.
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Desk accessories are designated by the .ACC file extender. You can 
disable a desk accessory by changing its extender to .ACX (or any 
other combination except .ACC), then restarting your computer. By 
doing this you can store many desk accessories on one disk, but load 
only those you want to use at a particular time. Before changing its 
extender, make sure the desk accessory file’s attribute is set to 
Read/Write. (See Show Info in Chapter 4 for more information.) To 
enable a desk accessory, change its extender back to .ACC.

Desk accessories can be accessed from the desktop or from any 
application using the menu bar, and are found under the leftmost 
menu heading (usually Desk). You can have up to six desk acces­
sories loaded at once. However, if you switch on your computer 
without first inserting a disk containing desk accessory files into 
drive A, the Desk menu will contain only one item, Desktop Info.

Doing without the desk accessories does free some of the com­
puter’s memory, but usually you’ll want them present. (For more 
information, see Slow Boot/Fast Boot in Appendix B.)

To open a desk accessory, display the Desk menu and select the 
accessory.

Desktop Info

VT52 Enulator

Desk File View Options
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Control Panel
The Control Panel lets you set a variety of features which affect 
the system as a whole. The Control Panel has seven sections: clock/ 
calendar, keyboard response, mouse double-click response, audio 
feedback, palette control, RS232 configuration, and printer 
configuration.

Select Control Panel from the Desk menu. The Control Panel win­
dow appears:

Palette Control —

RS232 Configuration----- «►

Close Box ------*-
Move Bar

Clock/Calendar

Keyboard Response

Mouse Double-Click Response

Cancel Button

Audio Feedback

Printer Configuration

Once you:ve set the Control Panel options, select the close box in 
the upper left corner. To cancel any setting changes you make, 
select the Cancel button.

Note: Any changes you make to the Control Panel can be saved 
to disk See Save Desktop in Chapter 4.

Clock/Calendar
The ST Computer uses the clock/calendar to mark individual files 
with the date and time they were created or revised.

To set the clock or calendar, select either the clock window (left 
window) or the calendar window (right window). The window highlights 
to mark your selection. Press [Backspace] or the [Left Arrow] key to 
position the cursor in the block, or press [Esc] to erase the block. 
Then enter the correct time or date from the keyboard. When you 
finish, select the window again (or press [Return]).

Note: If you move the cursor into the block but do not enter a 
new time or date, the original reading will reappear when you 
select the window.
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Once you set the time and date, the computer tracks the passage 
of time. If you have installed the clock batteries (see Chapter 1), 
the computer continues to track time even when your system is 
turned off. If you have not installed the batteries but still want an 
accurate dating of your files, you must reset the clock/calendar 
each time you switch on your computer.

Keyboard Response
Every key on the ST Computer keyboard responds when you press 
it, and every key (except [Shift], [Control], and [Alternate]) will 
repeat if you hold it down. The keyboard response controls how 
fast the keys respond and how quickly they repeat.

The upper slide (finger/key icons) controls how soon a key responds 
once it is pressed. Moving the slider to the left makes the keys 
respond sooner. Drag the slider to the desired position, then release 
the left mouse button.

Key Response

Respond Sooner Respond Later

The lower slide (rabbit and turtle icons) controls the speed at which 
the keys repeat when they’re held down. Moving the slider to the left 
makes the keys repeat faster. Drag the slider to the desired position, 
then release the left mouse button.

Key Repeat Rate

Repeat Faster —- Repeat Slower

You can test your new settings by turning up the volume on your 
monitor and pressing [Space Bar], Judge the responsiveness by 
listening to the clicks.

Mouse Double-Click Response
If you do not double-click quickly enough, your computer may inter­
pret the double-click as two separate clicks. To slacken the com­
puter’s double-click response (so that you can double-click more 
slowly), select a numbered box nearer to the resting mouse icon.
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Shaded Bell Button

Primary-Color Slides

For experienced users, a slower double-click response may be 
inconvenient. To quicken the computer’s double-click response (to 
accommodate fast double-clicks), select a numbered box nearer to 
the running mouse icon.

Slower Double-Clicks Faster Double-Clicks

Audio Feedback
The ST Computer has two kinds of audio feedback: a click signaling 
each keystroke and a bell signaling keyboard or mouse errors. (An 
example of a mouse error is trying to select another function before 
exiting a dialog box.) These sounds are emitted from your monitor’s 
speaker. To control audio feedback, select the keytop button or the 
bell button. An unshaded button means the function is enabled; a 
shaded button means it is disabled.

Unshaded Keytop Button

Palette Control
The palette control is fully functional only when you are using an 
ATARI RGB Color Monitor for your video display.

— Palette Boxes



In low resolution, the ST Computer can display up to 16 of the 512 
colors at one time (all 16 palette boxes are active). In medium res­
olution, the computer can display up to four colors at a time (the 
first two palette boxes in each row are active).

The palette boxes along the bottom of the Control Panel display 
swatches of color that you can modify. The primary-color slides 
allow you to mix the three primary video colors (red, green, and 
blue) to make a palette of the colors you want. The ST Computer 
offers a complete palette of 512 colors to choose from.

Select a palette color to modify by clicking the left mouse button 
on one of the active palette boxes. To modify the selected color, 
move any or all of the three primary-color sliders to the position 
you want. Move a slider by dragging it or by selecting the R (red), 
G (green), or B (blue) at the top or bottom of the slider. Each 
slider has eight positions (0 through 7). Selecting a higher- 
numbered position increases the primary color’s brightness in 
the selected palette color.

When you are using an ATARI Monochrome Monitor, the palette 
control lets you select either black text and graphics on a white 
background (default) or white text and graphics on a black back­
ground. To reverse the current monochrome display, set all the 
sliders for the upper-left palette box to the 0 or 7 position.

RS232 Config
The port labeled “Modem” on the back of the ST Computer is an 
RS232 serial port. By connecting a modem to your computer, you 
can communicate with other computers. You can also connect a 
serial printer or any other RS232 device to the modem port.
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To configure your RS232 port, select the RS232 Config button from 
the Control Panel. The RS232 Port Configuration box appears:

The RS232 Port Configuration box lets you match the computer’s 
RS232 port with the configuration of the modem (or serial printer) 
you are using. Refer to the manual supplied with your peripheral 
for specific information on which parameters to choose.

Once you’ve configured the RS232 port, select OK. Select Cancel 
(or press [Return]) if you do not want to change the parameters.

Baud Rate
Baud rate is the speed at which data is transmitted. (Baud, the stan­
dard unit measure of transmission speed, is the number of signaliz­
ing elements per second.) The fastest rate available to you is 19,200 
baud; the slowest is 50 baud. You must set baud rate to accommo­
date both your modem and the remote computer’s modem.

To set baud rate, use the two arrowed buttons on the left and right of 
the baud rate number. Selecting the right (up arrow) button increases 
the number; selecting the left (down arrow) button decreases the 
number. Pressing and holding down the left mouse button on either 
button will cycle the number rapidly.
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Parity
Whenever computers transmit data through telephone lines, there 
is a chance that some of the information can become garbled, often 
due to imperfections and noise within the lines. Parity is a method 
that computers use to examine information and determine whether it 
has been cleanly transmitted. The parity bit is a binary digit added to 
a group of bits to make the total of all bits odd or even. Depending on 
your modem and the remote device, you will choose either None, 
Odd, or Even. (Refer to the manual supplied with your modem for 
specific information.)

Duplex
Half Duplex configures the port for local echo: the characters you 
type are displayed on screen, then sent through the serial port. 
Full Duplex configures the port for host echo: the characters you 
type are sent directly out the serial port, then the host computer 
echoes them back to your computer. Most host computers allow 
Full Duplex transmission.

Bits/Char
Each character is stored in memory as one byte. A byte is made up of 
eight bits. Depending on the remote device, you may need to change 
the number of bits per character when transmitting through the 
RS232 port.

Strip Bit
The Strip Bit selector determines whether the transmitted char­
acters’ eighth bits are “stripped” (set to zero). If your system 
works correctly with eight-bit characters, you’ll usually select Off; 
that is, the eighth bit will not be stripped.

Xon/Xoff and Rts/Cts
These two choices represent flow-control protocols. When trans­
mitting through the RS232 port, your computer and the remote 
device must be able to signal one another when to start or stop 
sending information. Choose the flow control that the remote 
device supports.
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Printer Config
The printer configuration option is a system-wide installation which 
provides information to any utility or application. Whether or not a 
given program checks the printer configuration information before 
printing depends on the particular program. For example, the Print 
Screen option under the Options menu on the GEM desktop uses 
the printer configuration information, but other utilities or applica­
tions may not. Check the manuals supplied with your programs to 
see if they make use of the printer configuration information.

To configure your printer, select the Printer Config button from the 
Control Panel. The Install Printer box appears:

Printer Type:
Color:

Pixels/Line:
Quality:

Printer Port:
Paper Type:

OK | |Cancel |

INSTALL PRINTER

The Install Printer box lets you tell the computer which type of printer 
you have connected to the system, as well as which features of the 
printer you want the computer to activate when printing. Once you’ve 
set the parameters, select the OK button. Select Cancel (or press 
[Return]) if you do not want to change parameters.

Printer Type
Your choices are Dot (dot matrix printers) and Daisy (daisywheel 
printers). Select the appropriate box for your printer.

Color
Your choices are B/W (black and white, or monochrome, printers) 
and Color (color printers). Select the appropriate box for your 
printer.



Pixels/Line
The Pixels/Line option is used by dot matrix graphics printers only. 
Pixel means picture element. On dot matrix printers, a pixel is a 
dot. Dot matrix printers print a certain number of pixels per line 
when printing in graphics mode. If you have an ATARI Dot Matrix 
Graphics Printer, select 1280. If you have an Epson™, or Epson- 
compatible dot matrix graphics printer, select 960. Both values 
assume an eight-inch printed line.

Quality
The Quality option is used by dot matrix printers only. Select Draft 
for draft-quality printing; select Final for printing that is letter or 
near-letter quality (your printer must be able to support near-letter­
quality printing).

When printing graphics, your printer will often make only one pass 
of the print head if set to Draft. For darker graphics, select Final, 
but keep in mind that the printer will generally make two passes of 
the print head, and so take twice as long to produce the graphic.

Printer Port
If you have a parallel printer, select Printer. Parallel printers con­
nect to the port marked “Printer” on the back of your computer. If 
you are using a serial printer, select Modem. Serial printers con­
nect to the port marked “Modem” (the RS232 port) on the back of 
the computer.

Note: When using nearly all serial printers, be sure to configure 
the RS232 port for Xon/Xoff flow control (select On). Doing this 
enables the printer to signal the computer to temporarily stop 
sending it data so that it can print data it has already received. 
(See RS232 Config earlier in this chapter.)

Paper Type
If your printer feeds paper automatically by means of a tractor or 
single-sheet feeder, select Feed. If your printer accepts only a 
sheet at a time which you must insert manually, select Single. The 
Single option prevents the printer from printing beyond the end of 
a page, in case your document runs longer than a single sheet.



VT52 Emulator
The VT52 Emulator is an industry-standard telecommunications 
terminal program. When a modem is connected to your ST Com­
puter, this program lets your computer communicate with other 
computers. Since the program is a bare terminal emulator only, it 
is most useful when used to hook into a large mainframe system.

Select VT52 Emulator from the Desk menu. The VT52 Emulator 
appears on screen:
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX*
I Atari UT52 Terninal Enulator
I Copyright Atari Corporation 1387 I 
xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx 
Press:
1) UNDO to return to desktop.
Z) HELP to configure terninal.

To configure the Modem port, press [Help], then refer to the instruc­
tions in RS232 Config earlier in this chapter. To return to the GEM 
desktop, press [Undo].





CHAPTER 6
ADVANCED GEM FEATURESri

The GEM desktop offers several advanced features for working 
with your ST Computer. Once you become comfortable operating 
your computer, you’ll find that these features make your work 
even easier and more efficient.

Customizing Your Desktop
As you become more familiar with using your ST Computer, you may 
want to rearrange the GEM desktop. For instance, you might want to 
move the trash icon, line up the disk icons horizontally, or have your 
startup screen display several open directory windows. The GEM 
desktop lets you modify your work area to suit your personal prefer­
ences, then save the desktop in the new arrangement.

Arranging and Renaming the Desktop Icons
Arrange your disk and trash icons by dragging them to new positions 
on the desktop (you may want to close all windows first). Placing 
icons in a vertical line gives you room to open tall windows; placing 
them in a horizontal line gives room for wide windows. Placing the 
trash icon away from the disk icons protects you from accidentally 
dragging files to it instead of to a disk.

Rename a disk icon by selecting it, then selecting the Install Disk 
Drive option from the Options menu. When the Install Disk Drive 
dialog box appears, edit the current name to a new name. Do not 
change the letter in the Drive Identifier line. (For more information, 
see Install Disk Drive in Chapter 4.)

INSTALL DISK DRIVE

Drive Identifier: A 
Icon Label: INTERNALl

I

Install | | Renove | | Cancel

Note: You cannot rename the trash icon.



Arranging Directory Windows
Arrange directory windows on your desktop by opening the win­
dows you want, then moving and sizing them to suit your needs. 
(You can have up to four directory windows at a time open on the 
desktop.) Select options from the View menu to determine how 
filenames will be shown (as text or as icons) and sorted (by name, 
date, size, or type). Tall windows work well for text; wide windows 
work well for icons. If you show filenames as text, you may want 
to narrow your windows to show the filename only.

Close the windows with the close box to preserve their positions and 
sizes when you save the desktop. The next time you open directory 
windows, they will appear in the established positions in the reverse 
order you closed them. For example, the last window you close will 
establish the position of the first window you open.

If you leave the windows open when you save the desktop, they 
will open to the same size and position the next time you switch 
on the computer. The window that is active when you save the 
desktop will be the active window the next time you switch on your 
computer.

Desk File View Options

Sample Customized Desktop

90



Saving the Desktop
To save your customized desktop, make sure there is a formatted disk 
in drive A and that it is not write-protected. Then select the Save Desk­
top option from the Options menu. Doing this creates a DESKTORINF 
file on the disk in drive A, preserving your custom settings. Whenever 
you switch on the ST Computer with DESKTOP.INF on the disk in 
drive A, the first screen displayed will be your customized desktop.

A good disk to use when saving your desktop is the working copy 
of the disk supplied with your ST Computer. This disk also contains 
the desk accessories. With this disk in drive A, you can install your 
desk accessories and display your customized desktop whenever 
you switch on your computer.

Note: If you are using a hard disk, the computer writes the DESK­
TOP.INF file to the main directory of that disk. When you switch on 
the computer, it checks the disk in drive A first for a DESKTOP.INF 
file. If it doesn’t find one there, it reads the DESKTOP.INF file on your 
hard disk.

Making Your Own Boot Disks
The boot disk is the disk inserted in drive A when you switch on your 
computer. It usually contains desk accessories and the DESKTOP.INF 
file. You can make your own boot disk by saving your customized 
desktop to a blank disk, then copying the desk accessories to the 
same disk.

It’s sometimes convenient to have more than one boot disk on hand. 
You can make several boot disks, each containing selected desk 
accessories and a different DESKTOP.INF file. This provides you 
with a number of GEM desktop variations to choose from when start­
ing up your computer, depending on the work you’re going to do.

Editable Dialog Boxes
The GEM desktop uses both simple and complex dialog boxes. 
Simple dialog boxes act as queries or reminders in the process of 
using the desktop. You answer these boxes by selecting a dialog 
button. Complex dialog boxes ask you to type or edit information in 
the dialog box, using the computer keyboard. These editable dialog 
boxes follow a series of standard rules.
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Editable dialog boxes contain dashed lines, called editable text fields, 
on which you can type and edit text. In the text field, a vertical cursor 
(|) indicates where the next character you type will appear.

Editable Dialog Box

NEU FOLDER

Nane: I ._ _

| OK | | Cancel

To move the cursor to an editable text field, select the text field. The 
cursor jumps to that line and you may begin typing text.

The following keys have a special effect in an editable dialog box:

[Left Arrow]

[Right Arrow]

[Down Arrow] 
[Up Arrow] 
[Backspace]

[Delete]

[Esc]
[Return]

[Tab]

Moves the cursor one character to the left within 
the text field without erasing text.
Moves the cursor one character to the right within 
the text field without erasing text.
Moves the cursor to the next text field.
Moves the cursor to the previous text field.
Deletes the character and the character space to 
the left of the cursor.
Deletes the character and the character space to 
the right of the cursor.
Clears the current text field.
Selects the dialog button with an enlarged border, 
if one is present.
Moves the cursor to the next text field (same as 
[Down Arrow]).
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Some text fields contain punctuation marks such as periods (.) or 
slashes (\) to divide text on a line. To advance past a punctuation 
mark, type that mark. For example, you may see a text field with a 
period dividing the line, like this:

Pathname

Directory 
Window

Advance to the second part of the line by typing a period.

Using the Item Selector
The GEM item selector is an editable dialog box specialized for 
loading and saving files. The item selector is used by many appli­
cations programs and appears only when you are using one of 
those applications.

Directory Line

election:

Cancel

■ TXT 
.RKS 
.TXT

Directory: 
fl:

GAMES. 
LAND— 
ALL3.7 
ALPHA 
BOOK
BUSHING .3D_ 
BUSINESSiPRO 
CAMPUS .TXT 
CHAPTER1.DOC

ITEM SELECTOR

Selection Line

Vertical Cursor

Selecting a File in the Item Selector
In an item selector, the pathname of the current directory appears 
on the directory line and the items to choose from are displayed in 
the directory window.

The items in the directory are sorted alphabetically, folders before 
files. If the directory holds more items than it can display at once, 
you can scroll it in the same way you scroll a disk directory (see 
Scrolling a Window in Chapter 3).



You can select an item from the directory in three ways. The first 
way is by clicking the left mouse button on the item. The item 
highlights and is copied to the selection line. Then select OK (or 
press [Return]). The second way is by double-clicking the left 
mouse button on the item. The third way is by typing the item’s 
name on the selection line (or by typing a new name, if you want 
to create an item), then selecting the OK button. Make sure the 
vertical cursor is on the selection line before you begin typing.
Selecting a File

Selected File

ITEM SELECTOR

Directory:
______________________________________ ___ _______________________________________________________________________

Selection: 
HYPERFRC.TXT

I:::::::::::::::::::::::::: A 1 n

DISKTEST.TOS 
FRACTAL .DBA 
GAME .DAT 
GAME .PRG 
GRAPHICS.TTP 
HELP .MSG

0

HYPERFRC.TXRB
HYPRFRC2.TXT*
INTRO .HLP 0

Cancel

Selection Line

Folders are listed at the top of the directory and marked with a 
folder symbol. Open a folder directory (subdirectory) by selecting 
a folder name. Close a folder directory by selecting the close box 
in the upper left corner of the directory window.
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Opening a Folder Directory

Close Box

Folder Symbol

ITEM SELECTOR

Directory: 
fi:_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _

H CAME_ _ _ _ _  
S LAND___ _ _ _ _

ALL3.7 .TXT 
ALPHA .RKS 
BOOK .TXT 
BUSHING . 3D_ 
BUSINESS.PRO 
CAMPUS .TXT 
CHAPTER1.DOC

^election:

Cancel

Using the Directory Line
In an item selector, the current directory’s pathname appears on 
the directory line. The pathname contains a disk identifier, and 
may contain folder names and a filespec (short for file specifier). 
The directory line is an editable text field.

Filespec

Scroll Bar
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The disk identifier shows which disk is in use. It includes a letter 
specifying the disk, a colon (:), and a backslash ( \). To change 
the disk identifier, move the vertical cursor onto the line. Delete 
the letter of the disk identifier and type in a new letter. (For example, 
type “B” to access drive B.) Delete the pathname, if one is showing. 
Finally, click the left mouse button on the scroll bar. The directory 
window is updated to list a directory for the new disk.

Folder names in the pathname list all folders that were opened to get 
to the current directory. Each folder name is followed by a backslash. 
The easiest way to change a folder name is to open or close folders 
from the directory window. You can also edit the folder names by 
typing on the directory line, making sure to follow each folder name 
with a backslash.

Note: The [ \ ] key is located next to the [Return] key on the 
keyboard.



The filespec consists of a search criterion which may include 
letters, numbers, and wildcard characters (* and ?). The filespec 
specifies which files will appear in the directory window. By editing 
the filespec, you can choose which files or types of files to display.

The filespec is similar to a filename. It contains a mandatory name 
of up to eight characters and an optional extender of up to three 
characters. A filespec uses two special characters, called wild­
cards: the asterisk (*) and the question mark (?).

An asterisk in a filespec stands for all characters and combina­
tions of characters, and can replace an entire name or extender. 
For example, the filespec
★ *

allows all filenames with all extenders to be displayed. A filespec will 
often have an asterisk as the name but specify the extender explic­
itly. For example, the filespec
*.DOC
allows all filenames with the .DOC extender to appear in the direc­
tory. This filespec would show the files
LETTER.DOC
ATARI. DOC
MOM.DOC
but would not show
FRANCE.TXT
The asterisk must be the last character in the name or extender of a 
filespec. For example, the filespec
TAX*. DOC
is valid, but the filespec
T*X.DOC
is not valid.
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The question mark in a filespec stands for all single characters.
For example, the filespec
MOM?.LET
specifies all files which begin with MOM, which have any character 
in the fourth position of the name, and which have the extender .LET. 
This filespec would display the files
M0M1.LET
M0M4.LET
MOMZ.LET
but would not show
JACK. LET
MOM33.LET
M0M1.D0C
The filespec

???

is equivalent to

You can combine wildcards and characters. For example,
?ABC*.P?I
l?D?B.*
are both valid filespecs.

To change a filespec, edit it on the directory line, then update the 
directory window by clicking the left mouse button on the scroll bar.

Installing an Application
When you view a directory window on the GEM desktop, you may see 
both program and data files listed. In order to work with a data file, 
you usually must first open, or run, a program file. The GEM desktop 
has a feature, Install Application, that lets you open a data file, in its 
program environment, directly from the directory window.

You install an application by selecting the Install Application option in 
the Options menu. In the dialog box that appears, you must specify 
both an application name and a document type. You can also specify 
the application type, although the default, GEM, will most generally 
be used.
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Specifying the Application Name and Document Type
The application name is the filename of the application you want 
to install. The document type is the common extender of the files 
that use that application. For this example, the application name 
WORDPROC.PRG and the document type .DOC are used. Replace 
them with your chosen application name and document type when 
you install an application. Follow the steps:
1. From an open directory window, select the program file 

WORDPROC.PRG.
2. Select Install Application from the Options menu.

Install Application

■/ :

HORDFROC

Desk File View

DISK

Install Disk Drive...
202372 bytes used in 8 itens.

Set Preferences.,.
Save Desktop
Print Screen

DOC HOME.DOC

L-F
DESK .DC

Options

PRG

3. The Install Application dialog box appears, listing WORDPROC.PRG 
as the application name. Specify the document type by typing 
“DOC.”

INSTALL APPLICATION

Application Nane: WORDPROC.PRG 
Docunent Type: DOC 

Application Type:

GEM TOS-takes paraneters

OK | | Cancel

4. Select the OK button (or select Cancel or press [Return] to 
stop the operation).
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When you select the OK button, the application WORDPROC.PRG is 
installed with the document type .DOC. Now when you want to use 
one of the application’s .DOC files, double-click on that .DOC file in 
the directory window. The ST Computer will run WORDPROC.PRG, 
then load the .DOC file you opened within the application environ­
ment. To preserve the installation of WORDPROC.PRG, select Save 
Desktop from the Options menu (see Save Desktop in Chapter 4).

In order to use the installed application, the application file must be 
present on the same disk as the data files (preferably in the same 
folder but never in a different folder) or on the disk in drive A.

Note: An application may not recognize that it has been installed. 
For specific information, consult the manual that describes your 
application.

Specifying the Application Type
Most programs you run from the GEM desktop will have the extender 
.PRG or .APP. Both of these extenders indicate a GEM application. 
However, some applications have the extender .TOS or .TTP. The 
extender TOS indicates a TOS application; the extender TTP indi­
cates a TOS-takes parameters application.

The easiest way to use a .TOS or .TTP application is this: first, 
select the application; second, select Install Application from the 
Options menu; third, select the GEM dialog button; and finally, 
select the OK button. The application will now run as a GEM appli­
cation, regardless of its extender.
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APPENDIX A
MOUSE POINTER CONTROL
QUICK REFERENCE
The mouse pointer can be moved around the GEM desktop by 
using either the mouse or certain keystroke combinations on the 
ST Computer keyboard. To use the keystroke combinations, hold 
down the first key listed and press the second key (or hold down 
the first two keys and press the third key).

The following table lists mouse functions and keystroke combina­
tions. You can copy this page and post it near your ST Computer 
for quick reference.

Action Mouse Function Keystrokes

Move pointer. Roll mouse in desired 
direction.

[Alternate] [any Arrow 
key] (moves pointer 
eight pixels in arrow 
direction).

[Alternate] [Shift] [any 
Arrow key] (moves 
pointer one pixel in 
arrow direction).

Select item. Position pointer on item, 
click left mouse button.

Position pointer on item, 
press [Alternate] 
[Insert].

Select and 
open item.

Position pointer on item, 
double-click left mouse 
button.

Position pointer on item, 
hold down [Alternate], 
quickly press [Insert] 
twice.

Drag item. Select item, hold down 
left mouse button, roll 
mouse in desired 
direction.

Select item, press 
[Alternate] [Insert] [any
Arrow key].

Right mouse 
button 
functions.

Click right mouse button. [Alternate] [Clr Home].
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APPENDIX B 
TROUBLESHOOTING AND
PREVENTIVE MAINTENANCE
Troubleshooting
If you run into problems hooking up or operating your ST Com­
puter, don’t panic. Chances are the difficulty is something you can 
take care of yourself. This appendix describes some possible prob­
lems and suggests simple solutions.

It Just Won’t Work
If your ST Computer just won’t work—for instance, the power light 
won’t come on or the monitor stays dark—the remedy is usually a 
simple matter. Follow these steps:
1. Switch off all components in your system (the computer, external 

drives, the monitor, and any other peripherals). Now make sure 
all cable connections are correct and secure. Check to see that 
the power cables are connected properly and that the video cable 
is attached firmly to both the computer and the monitor. Check 
the integrity of your wall socket or power strip by plugging in a 
desk lamp.

2. Turn on all your components in the order described in Chapter 1. 
Be certain that the keyboard’s front panel power light, the internal 
disk drive’s busy light, and the monitor’s power light all come on.

3. Check the brightness and contrast adjustments on your monitor. 
Make sure they are turned up.

No Desktop
If all the proper power lights come on, the monitor brightens, and 
the internal drive’s busy light illuminates, but you cannot get to the 
GEM desktop, you may have a bad desk accessory on your boot 
disk, or the DESKTOP.INF file may be garbled.

With your computer switched off, place the original disk supplied 
with your ST Computer into the internal drive and turn on the 
power. If the problem is solved, make a new copy of the original 
disk and use that as your boot disk. Discard the disk that was 
causing the problem.
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If the problem persists, remove the disk from the internal drive, 
then switch on your computer. (It may take up to 40 seconds to reach 
the desktop without a disk in drive A.) If the desktop appears, the 
problems you were experiencing may be related to a bad desk acces­
sory on the original disk. Contact your ATARI representative for a 
new disk.

Software Problems
If you are having problems with an application, it may be that the 
software contains imperfections (bugs) or that the disk contains 
garbled data. Try switching your computer off for ten seconds, then 
on again (make sure you have a boot disk in drive A). Then rerun the 
application. If this helps, it may mean the application experienced a 
momentary failure.

If you still experience problems, try switching on the system using 
another boot disk and a backup copy of the software application. If 
this works, the problem is probably with the original disks you were 
using. If none of your disks work well, your computer or disk drive 
may need repair.

Bombs
Sometimes applications develop errors that are potentially damag­
ing to the ST Computer’s operating system. When an application is 
running and such an error occurs, TOS detects it and terminates 
the program. As a signal to you, TOS displays a row of bombs 
across the screen while it attempts to recover from the error.

To protect the computer’s operating system, switch off your com­
puter when you see bombs displayed. Wait ten seconds, then 
switch on your computer. If the problem recurs, discontinue using 
the program.

Slow Boot/Fast Boot
If you don’t have a disk inserted in drive A when you first switch 
on the computer, the GEM desktop takes about 40 seconds to 
appear. This is called a slow boot. (Booting the computer means to 
begin its operation.)

On the other hand, you can fast boot by inserting a disk without desk 
accessories in drive A before switching on'the system. This kind of 
boot is faster than booting with a disk containing desk accessories.
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In both slow and fast boot, once the desktop appears you won’t 
have any desk accessories available in the Desk menu.

Note: It’s sometimes convenient to have more than one boot disk on 
hand. You can design your boot disks to contain no desktop acces­
sories, selected desktop accessories, or various DESKTOP.INF files. 
This gives you several booting options, depending on the work you 
want to do.

The Mouse
With time, your mouse may begin to move slowly or sporadically.
If this happens, make sure the mouse is plugged firmly into 
mouse/joystick port 0. If the problem persists, the mouse may 
need cleaning. Refer to the ST Mouse manual supplied with your 
mouse for instructions.

The Keyboard
Typing from the keyboard generally produces nothing on the GEM 
desktop except when you are naming items in a dialog box. How­
ever, you can use the keyboard to control the mouse on the desk­
top (see Controlling the Mouse Pointer from the Keyboard in 
Chapter 2).

The Monitors
If you have both an ATARI RGB Color Monitor and an ATARI Mono­
chrome Monitor set up side by side, make sure only the one currently 
connected to your computer is switched on. With both monitors 
switched on, you may get interference patterns on screen. If you only 
have one monitor switched on and you get interference patterns, the 
trouble may be linked to some other peripheral. Try moving power 
supplies, printers, and modems as far away from the monitor as 
possible.
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Preventive Maintenance
To ensure top performance from your ST Computer system, follow 
the guidelines in this section.

Caring for Your ST Computer
• Always have your system securely placed on a firm, level surface.
• Avoid dusty or greasy work areas.
• Keep all components away from extreme heat or moisture.
• Keep all components out of direct sunlight.
• Do not move the components unnecessarily.
• Always switch your computer off before inserting or removing 

a cartridge.
• Always switch your computer and peripherals off before con­

necting or disconnecting components.
• When you switch off the computer, wait at least ten seconds 

before you switch it on again.
• Keep liquids away from the components.
• Avoid smoking near your computer system.
• Always switch off your system before cleaning it. Clean the out­

side of the components with a soft, slightly damp, lint-free cloth 
only. Do not use cleansers, abrasives, or solvents.

• To ship or store your system, repack it in the original factory 
packing materials.

Caring for Your MicroFloppy Disks
• Do not switch the disk drive off while its busy light is illuminated.
• Do not insert or remove disks while the drive’s busy light is on.
• Do not leave disks in the drive when the drive is off.
• Keep disks away from sources of magnetism (monitor, television, 

electric motor, telephone, etc.).
• Never leave disks in direct sunlight.
• Never touch or clean a disk’s magnetic recording surface inside 

the plastic casing.
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A Final Note
Your ST Computer system is designed for low maintenance and 
high reliability. But like anything electronic and mechanical, the 
equipment can break down.

If you experience problems that you think may be serious, take 
your ST Computer (or any other component) to an authorized 
ATARI Service Center. For the location of the nearest ATARI 
Service Center, contact your ATARI retailer (or see Customer 
Support at the end of this manual).
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APPENDIX C
MEGA ST COMPUTER SPECIFICATIONS
Computer
Processor

Memory:

MEGA ST1™

MEGA ST2™

MEGA ST4™

Graphics Resolution
(selectable)

Color

Interfaces

Sound Generator

Keyboard

Power Supply
(built-in)

Power Consumption

MC68000, 32-bit internal, 16-bit external 
architecture; 24-bit address bus; 8 MHz clock 
frequency

1 megabyte (1,048,576 bytes) of RAM;
192 kilobytes (196,608 bytes) of ROM
2 megabytes (2,097,152 bytes) of RAM;
192 kilobytes (196,608 bytes) of ROM
4 megabytes (4,194,304 bytes) of RAM;
192 kilobytes (196,608 bytes) of ROM

640 x 400 monochrome (high resolution) 
640 x 200 x 4 colors (medium resolution) 
320 x 200 x 16 colors (low resolution)

Palette of 512 colors

Midi In and Midi Out Ports
Monitor Port (RGB Analog; high-resolution mono­

chrome; and audio)
Parallel Interface Printer Port
RS232 Serial Modem Port
Floppy Disk Port (includes controller)
Hard Disk Port (10 megabits per second DMA 

transfer rate)
ROM Cartridge Port (128 kilobytes capacity) 
Mouse/Joystick and Joystick Ports 
Bus Extension for future expansion

3 voices from 30 Hz to above audible range; 
built-in amplitude envelopes and noise generator

Detachable 94-key intelligent keyboard using its 
own microcontroller

+ 5V @ 3A
+ 12V @ 1A 
-12V @ 30mA

95 Watts (maximum)
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Ambient Temperature

Relative Humidity
(noncondensing)

Physical
Characteristics

Internal Disk Drive
Track Density

Storage Capacity

Storage Medium

Head Positioning
Mechanism

Data Transfer Speed

Keyboard
Physical
Characteristics

41 to 113 °F (5 to 45 °C), operating or idle
- 4 to 149 °F (- 20 to 65 °C), storage
- 40 to 149 °F (- 40 to 65 °C), transport

20 to 80%, operating or idle; up to 95%, 
storage or transport

Height: 67 mm
Width: 340 mm
Depth: 400 mm
Weight: 4.3 kg
Internal power supply

135 tracks per inch

360 kilobytes per side (formatted MFM);
720 kilobytes total with double-sided

31/2-inch microfloppy disks, double-density, 
double- or single-sided, 135 tracks per inch

Stepper motor

250 kilobits per second

Maximum height: 40 mm
Width: 475 mm
Depth: 190 mm
Weight: 1.8 kg
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APPENDIX D
CONNECTOR PINOUT SPECIFICATIONS

Modem
1 — Protective Ground
2 — Transmitted Data
3 — Received Data
4 — Request to Send
5 — Clear to Send
6 — Not Connected
7 — Signal Ground.
8 — Data Carrier Repeat 
9-19 — Not Connected

Printer
1 — STROBE Output
2 — Data 0
3 — Data 1
4 — Data 2
5 — Data 3
6 — Data 4
7 — Data 5
8 — Data 6
9 — Data 7

14 15 16 17 18 19 20 21 22 23 24 25

1 2 3 4 5 6 7 8 9 10 1 1 12 13

20 — Data Terminal Ready
21 — Not Connected
22 — Ring Indicator
23-25 — Not Connected

25 24 23 22 21 20 19 18 17 16 15 14

13 12 1110 9 8 7 6 5 4 3 2 1

10 — Not Connected
11 — BUSY Input
12-17 — Not Connected
18-25 — Ground

Midi Out
1 — THRU Transmit Data
2 — Shield Ground
3 — THRU Loop Return
4 — OUT Transmit Data
5 — OUT Loop Return

Note: All pinout diagrams are from the external port view.
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Midi In
1 — Not Connected
2 — Not Connected
3 — Not Connected
4 — IN Receive Data
5 — IN Loop Return

Monitor
1 — Audio Out
2 — Composite Sync
3 — General Purpose Output
4 — Monochrome Detect
5 — Audio In
6 — Green
7 — Red
8 — Plus 12-Volt Pullup
9 — Horizontal Sync

13

10 — Blue
11 — Monochrome
12 — Vertical Sync
13 — Ground

Floppy Disk
1 — Read Data
2 — Side 0 Select
3 — Logic Ground
4 — Index Pulse
5 — Drive 0 Select
6 — Drive 1 Select
7 — Logic Ground
8 — Motor On
9 — Direction In

10 — Step

11 — Write Data
12 — Write Gate
13 — Track 00
14 — Write Protect
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Hard Disk
1 — Data 0
2 — Data 1
3 — Data 2
4 — Data 3
5 — Data 4
6 — Data 5
7 — Data 6
8 — Data 7
9 — Chip Select

10 — Interrupt Request
11 — Ground
12 — Reset

10 9876543 2 1

19 18 17 16 15 14 13 12 11

13 — Ground
14 — Acknowledge
15 — Ground
16 — A1
17 — Ground
18 — Read/Write
19 — Data Request

Cartridge
1 — + 5 VDC
2 — + 5 VDC
3 — Data 14
4 — Data 15
5 — Data 12
6 — Data 13
7 — Data 10
8 — Data 11
9 — Data 8

10 — Data 9
11 — Data 6
12 — Data 7
13 — Data 4
14 — Data 5
15 — Data 2
16 — Data 3
17 — Data 0
18 — Data 1
19 — Address 13
20 — Address 15
21 — Address 8
22 — Address 14

2 4 6 8 10 12 14 16 18 20 22 24 26 28 30 32 34 36 38 40

1 3 5 7 9 11 13 15 17 19 21 23 25 27 29 31 33 35 37 39

23 — Address 7
24 — Address 9
25 — Address 6
26 — Address 10
27 — Address 5
28 — Address 12
29 — Address 11
30 — Address 4
31 — ROM Select 3
32 — Address 3
33 — ROM Select 4
34 — Address 2
35 — Upper Data Strobe
36 — Address 1
37 — Lower Data Strobe 
38-40 — Ground
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Mouse/Joystick
1 — Up/XB
2 — Down/XA
3 — Left/YA
4 — Right/YB
5 — Not Connected
6 — Fi re/Left Button
7 — +5VDC
8 — Ground
9 — Joy1 Fire/Right Button

6 7 8 9

1 2 3 4 5

Joystick
1 — Up
2 — Down
3 — Left
4 — Right
5 — Reserved
6 — Fire Button
7 — + 5VDC
8 — Ground
9 — Not Connected

6 7 8 9

1 2 3 4 5
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APPENDIX E
CONNECTING A THREE-PIN PLUG 
TO THE MAINS LEAD
In the United Kingdom, the ST Computer operates on 
~240V 50 Hz mains supply.

The wires in this mains lead are colored in accordance with the 
following code:

Green/Yellow

Green/Yellow — Earth (E)
Blue — Neutral (N)
Brown — Live (L)

If the colors of the wires in the mains lead of this appliance do not 
correspond with the colored markings identifying the terminals in 
your plug, proceed as follows:

The wire colored GREEN/YELLOW must be connected to the 
terminal in the plug marked by the letter E or by the safety earth 
symbol i-, or colored GREEN, or GREEN/YELLOW.

The wire colored BLUE must be connected to the terminal marked 
with the letter N or colored BLACK. The wire colored BROWN must be 
connected to the terminal marked with the letter L or colored RED.

If a 13-amp (BS1363) plug is used, a 3-amp fuse must be fitted, or 
if any other type of plug is used, a 3- or 5-amp fuse must be fitted 
either in the plug, adaptor, or on the distribution board.
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GLOSSARY
.ACC The desk accessory extender?

Active Window The window on the GEM desktop that is currently avail­
able for desktop operations such as selecting, copying, and deleting items. 
The active window is the only window that you can scroll, update, move, 
or resize. Only one window at a time can be active on the desktop.

Alert Message A special type of dialog box designed to bring something 
to your attention. Alert messages are punctuated with stop signs, question 
marks, or exclamation points.

.APP An executable GEM program extender.

Application A program written to solve a specific problem or produce a 
specific result, and that can be executed by a computer. That is, the com­
puter is “applied” to the task. (See Program.)

Back Up To make an archive copy of a disk or file. Backing up disks 
ensures that information is not lost when the disk is accidently damaged 
or erased.

Baud The standard unit measure of transmission speed of data through 
a modem, calculated in signaling elements per second.

Baud Rate The speed at which data are transmitted from one source to 
another, usually from one computer through a modem to another 
computer.

Bee Icon The icon displayed on screen whenever the ST Computer trans­
fers or retrieves information from the disk drive. You cannot proceed to 
another action while the bee icon is on screen.

Bit The smallest unit of computer memory. Eight bits equal one byte. 
(See Byte.)

Blitter Chip A special co-processing circuit in the ST Computer. When 
enabled, it greatly improves the speed of text formatting and graphics 
operations.

Boot To begin the computer’s operation. Booting is usually accomplished 
by switching on your system. (See Coldstart and Warmstart.)

Boot Disk The disk inserted in drive A when you switch on (boot) your ST 
Computer. The boot disk usually contains desk accessories and the 
DESKTOP.INF file.

Busy Light The light on a disk drive that indicates it is reading from or 
writing to a disk.

Byte A unit of computer memory. Each byte consists of eight bits, and is a 
unique character within the computer. For example, the letter “a” is stored in 
memory as one byte. (See Bit and Kilobyte.)
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Cartridge A device usually containing files and data in ROM, that plugs 
into the cartridge slot on the left side of the ST Computer. Cartridge pro­
grams load instantly and do not use any of the computer’s memory to 
load.

Click To quickly press and release a mouse button. A click on the left 
mouse button selects items on the desktop. (See Double-Click and Shift- 
Click.)

Clock/Calendar The file-dating feature built into the ST Computer and set 
from the Control Panel. The clock/calendar requires two size AA batteries.

Close Box The small box in the upper left corner of an active window, 
used to close the current directory.

Coldstart Booting the computer by switching on the power. A coldstart 
can be initiated while the computer is running by switching off the power 
for ten seconds, then switching it back on. A coldstart completely initial­
izes the system. (Compare to Warmstart.)

Color Palette A feature in the Control Panel used to modify the colors 
available on the ST Computer. You must use an ATARI RGB Color Monitor 
or a composite monitor for the color palette to function fully.

Configure To customize the ST Computer system (environment) to your 
preferences; for instance, by setting colors, baud rate, confirmation, etc.

Control Panel A desk accessory used to alter and set many of the sys­
tem’s features and options, such as the color palette, mouse and key­
board response, and clock/calendar.

Copy To duplicate the information in a file, folder, or disk. To copy, drag 
the item from its original position on the desktop to another file, folder, or 
disk.

Current Directory The directory currently displayed in a window, as 
specified by the pathname in the move bar.

Cursor A marker that appears on the screen to indicate the position of 
the next action. Text cursors are usually either a blinking block or a solid 
vertical line. The mouse pointer is sometimes called a cursor.

Daisywheel Printer A type of printer that uses a rotating wheel to 
impact characters against a ribbon and onto the paper.

Data File A collection of information used by an application. Data 
file icons look like sheets of paper with one folded corner.

Default A value, option, or setting that the computer automatically 
selects until you direct it otherwise. For example, items on the GEM 
desktop are shown as icons, by default, until you change the option 
in the View menu.



Desk Accessory A special application that is loaded into memory 
from a disk in drive A when you switch on your computer. Desk 
accessories can be accessed either directly from the GEM desktop 
or from an application that uses the menu bar format. Desk acces­
sory files are identified by the .ACC extender.

DESKTOP.INF The file that holds your customized desktop data and 
is created by selecting the Save Desktop option in the Options menu. 
DESKTOP.INF must be in the root directory of the disk in drive A (or on 
the hard disk, if one is connected) in order for the computer to read it 
during booting.

Destination Disk The disk that information is written to during a 
Diskcopy procedure.

Dialog Box An interactive message box that the computer uses to 
communicate with you. To exit a dialog box, you must acknowledge 
the message or select an option.

Directory A list of files. (See Current Directory, Root Directory, 
and Subdirectory.)

Disk Drive The primary storage device for your ST Computer. The 
computer uses the disk drive to read information from or write infor­
mation to a disk.

Disk Identifier The letter in a pathname indicating which disk is in 
use. The letter is always followed by a colon (:) and a backslash (\). A 
disk identifier appears by itself in the move bar of a directory window 
when the root directory is displayed.

Diskcopy A procedure that duplicates data from one disk to 
another disk. To make a disk copy, drag the source disk icon on top 
of the destination disk icon. All information previously held on the 
destination disk is erased during Diskcopy.

DMA Port A high-speed peripheral port for attaching a hard disk 
drive or laser printer to the computer. DMA is an acronym for Direct 
Memory Access.

Document Something you create or modify using an application. Docu­
ments can contain text, graphics, or both. Also called a file. (See File.)

Document Type See Extender.
Dot Matrix Printer A type of printer that forms characters and graphics 
by printing small dots.

Double-Click Two quick clicks on a mouse button. A double-click on the 
left mouse button opens a file, disk, or folder.



Double-Sided Allowing use of both sides. A double-sided disk has both 
sides of its magnetic media certified as safe for storing data. A double-sided 
disk can store up to 726,016 bytes of data. A double-sided disk drive can 
read, write to, and format both single- and double-sided disks. (Compare to 
Single-Sided.)

Drag To move an item on the desktop. To drag, point the mouse pointer at 
an item, press and hold down the left mouse button, and move the mouse. 
While the item is being dragged, a ghost outline of it appears on the desktop.

Drop-Down Menu A list of options that appears below a menu heading 
when you touch the heading with the mouse pointer.

Editable Text Field A dashed line in a dialog box where you can type 
characters.

Expansion Connector An internal connector that permits installation of 
additional specialized hardware within your MEGA ST Computer. The 
signals provided include a direct extension of the microprocessor bus.

Extender The file type appended to the name of a file and separated 
from it with a period (.). An extender is optional and can have up to three 
characters (letters and numbers). Some common extenders are .ACC, 
.APP, .PRG, .TOS, .TTP.

File A collection of information that can be stored on a disk or in the 
computer’s memory.

Filename The name of a file, made up of a mandatory name and an 
optional extender, separated by a period. (See Extender and Name.)

Filespec The search criterion used in an item selector. Filespec is short 
for file specifier.

Floppy Disk A magnetic media used to store information generated 
on a computer. The disk is made of material similar to audio tape. (See 
MicroFloppy Disk.)

Folder A subdirectory for storing files and other folders. A folder appears 
as a folder icon (manila folder) on the desktop, or with a folder symbol 
(small box) next to its name when showing as text.

Format To set the circular patterns on a floppy disk that enable it to store 
information. Formatting erases all information previously stored on the disk.

Full Box The small box in the upper right corner of a window, used to 
change the size of a window alternately from smaller than full-screen to 
full-screen.

Function Keys The keys [F1] through [F10] along the top edge of the 
ST Computer keyboard. Many applications use these keys to perform 
special actions.
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GEM The portion of TOS that creates and manages all the windows, 
icons, menus, and graphics features of the ST Computer. GEM is an acro­
nym for Graphics Environment Manager.

GEM Desktop The main screen for the ST Computer. It includes (but is 
not limited to) the menu bar, two disk icons, and the trash icon.

Ghost Outline An outline of an icon, filename, or window used to show 
the current position of the item as it is dragged to a new location on the 
desktop.

Hard Disk A device used to store data on a magnetic surface. The disk 
itself is permanent (not removable). A hard disk drive can store far more 
data than a floppy disk drive, and can read and write information many 
times faster.

Hardware The actual physical apparatus of your computer system.
(Compare to Software.)

High Resolution One of three video display modes available with the 
ST Computer. In high-resolution mode, the computer’s display consists of 
640 dots horizontally by 400 dots vertically, in black and white. To use high- 
resolution mode, you must have an ATARI High-Resolution Monochrome 
Monitor. (Compare to Low Resolution and Medium Resolution.)

Icon A picture on the desktop that represents a disk, file, folder, or pro­
cedure. The disk icon looks like a filing cabinet; the data file icon looks 
like sheets of paper with one corner folded; the program file icon looks 
like a small desktop; the folder icon looks like a manila folder; and the 
trash icon looks like a trash can.

Information Line The line at the top of an active directory window imme­
diately below the move bar, telling how many bytes are used by the items 
listed in the directory, and how many items there are.

Initialize To set the computer to its starting configuration.

Input/Output (I/O) The communication process that takes place between 
the ST Computer and a peripheral device such as a disk drive or printer. 
Input is information the computer receives (that is, it is sent in); output is 
information the computer transmits (that is, it is sent out).

Interface An electronic connection that allows communication between 
the computer and its peripherals.

Item Selector An editable dialog box specialized for loading and saving 
files while using an application; sometimes called a file selector.

Joystick A device used to control the action of a computer game on 
screen.

Kilobyte 1,024 (210) bytes of memory. (See Byte.)
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Laser Printer A high-speed, high-resolution printer that electrophoto- 
graphically produces an image on paper.

Low Resolution One of three video display modes available with the ST Com­
puter. In low-resolution mode, the computer’s display consists of 320 dots 
horizontally by 200 dots vertically. In this mode and when connected to an 
ATARI RGB Color Monitor, the computer can display up to 16 colors at a time 
from the total palette of 512 colors. (Compare to High Resolution and 
Medium Resolution.)

Medium Resolution One of three video display modes available with the 
ST Computer. In medium-resolution mode, the computer’s display consists 
of 640 dots horizontally by 200 dots vertically. In this mode and when con­
nected to an ATARI RGB Color Monitor, the computer can display up to 
four colors at a time from the total palette of 512 colors. (Compare to 
High Resolution and Low Resolution.)

Megabyte 1,024 (210) kilobytes of memory. (See Kilobyte.)

Memory The electronic circuits that the ST Computer uses to store data 
and programs. There are two kinds of computer memory: RAM (Random 
Access Memory) and ROM (Read Only Memory). RAM loses its data if the 
power is turned off; ROM retains its information whether the computer has 
power or not.

Menu Bar A bar at the top of the GEM desktop. When you first start up the 
ST Computer system, the headings on the menu bar are Desk, File, View, and 
Options. Other application programs may show different headings in the 
menu bar.

MicroFloppy Disk A 31/2-inch floppy disk enclosed in a hard plastic casing; 
the main type of disk used with the ST Computer. A single-sided microfloppy 
disk can store up to 357,376 bytes of information; a double-sided microfloppy 
disk can store up to 726,016 bytes of information. (See Floppy Disk.)

MIDI A standard interface designed to connect a computer to a number 
of electronic musical devices. MIDI is an acronym for Musical Instrument 
Digital Interface.

Modem A device that enables you to connect your computer directly to 
the telephone lines in order to establish a communication link with other 
computers and online information networks. Modem is a contraction of 
MOdulator/DEModulator.

Monitor See Video Display.

Mouse A small, hand-manipulated device connected to your ST Computer 
that controls the movement of a pointer on the desktop. As you slide the 
mouse across a table or desk, the small roller on the bottom rolls back and 
forth to track the movements. The mouse has two buttons. The left button is 
used for most desktop operations. The right button is used with some 
applications programs.
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Mouse Pointer The small image on the screen that moves when you 
move the mouse. The mouse pointer is usually an arrow, but it may 
change to other shapes such as a bee icon during certain procedures.

Move Bar The bar at the top of an active window. Use the move bar to 
drag a window to a new location on the desktop.

Name The identifying name of a file. A name is mandatory and can have 
up to eight characters (letters and numbers).

Option An item in a drop-down menu that enables you to manipulate the 
desktop and the elements on it.

Parallel Interface An industry-standard interface for printer connections. 
The parallel interface port on the back of the ST Computer is labeled 
“Printer.”

Parameter Data given to a program that controls its operation.

Pathname The list of items that specifies the path through the subdirec­
tories on the disk to the current directory. A pathname consists of a disk 
identifier and a string of folders separated by backslashes (for example: 
A: \ document \ text \). It may also contain a filespec.

Peripheral Any external device, such as a disk drive, monitor, or printer, 
that you connect to your computer.

Pixel A dot on the ST Computer’s video display. Pixels are arranged in a 
grid, and set to either 320 x 200, 640 x 200, or 640 x 400 dots per grid 
depending on your screen resolution. Pixel is short for picture element.

Pointer See Mouse Pointer.

.PRG A GEM application file extender.

Program A detailed and explicit set of instructions for accomplishing 
some purpose, expressed in a language that can be read by a computer. 
(Compare to Application.)

Program File A file that contains an applications program. The program 
file icon looks like a small desktop. Double-click the left mouse button on 
a program file to execute the application.

Prompt Any symbol or message on screen indicating that the computer 
is awaiting input from the user.

RAM The part of the computer’s memory that is used to write data to 
and read data from a disk. When you work with your computer, the infor­
mation displayed on the monitor screen is in RAM. Information stored in 
RAM is lost when you switch off the computer. RAM is an acronym for 
Random Access Memory.



RAM Disk A part of RAM that is segmented to act as a disk drive. RAM 
disk drives are much faster than floppy or hard disk drives, but all informa­
tion in a RAM disk is lost when the computer is turned off.

RGB The color signals that the ST Computer produces to create its special 
color display. The combinations of eight different intensities of red, green, 
and blue enable you to create 512 colors with the ST Computer. RGB 
stands for Red, Green, Blue.

ROM The part of the computer’s memory containing TOS, GEM, and the 
GEM desktop. ROM never changes, and retains its information with or with­
out power to the computer. ROM is an acronym for Read Only Memory.

Root Directory The first directory you encounter when you open a disk 
drive. The root directory is the directory outside of all folders and is speci­
fied by the disk identifier alone (such as A: \ ).

RS232 An industry-standard connection for peripherals. The RS232 port 
on the back of the ST Computer is labeled “Modem.” This port is some­
times referred to as the serial port.

Scroll To move the directory in a window left, right, up, or down.

Scroll Bar One of two bars that border an active window on the bottom 
and right edges. The scroll bars contain the scroll arrows and are shaded 
if part of the window’s contents cannot be seen. The larger the shaded 
portion, the greater the percentage of the window’s contents that is hid­
den from view.

Sector A section of a track on a hard or floppy disk. Sectors are usually 
128, 256, 512, or 1024 bytes long. On a microfloppy disk, the sectors are 
512 bytes long. (See Track.)

Selecting Clicking the left mouse button on an icon, file, or menu option. 
Selected icons and files highlight to indicate the selection.

Serial One bit at a time. (See RS232.)

Shift-Click Clicking with a mouse button while holding down the [Shift] 
key.

Single-Sided Allowing use of one side only. A single-sided disk has only 
one side of its magnetic media certified as safe for storing data. A single­
sided disk can store up to 357,376 bytes of data. A single-sided disk drive 
can read, write to, and format only single-sided disks, or double-sided 
disks that have been formatted as single-sided. (Compare to Double-Sided.)

Size Box A small box at the lower right corner of a window, used to 
change the window’s size or shape.

Sizing The process of changing the size or shape of a window.
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Software The programs and applications you run on your computer.
(Compare to Hardware.)

Source Disk The disk that information is written from during a Diskcopy 
procedure.

Subdirectory A directory inside a directory; often called a folder. (See
Root Directory.)

.TOS The TOS application file extender.

TOS The operating system for the ST Computer. TOS controls how the 
computer operates the GEM desktop, the mouse, and any peripherals 
connected to the computer. TOS is an acronym for The Operating System.

Track One of the circular paths on a disk that contain the data written on 
the disk. Each track is made up of smaller sections called sectors. (See 
Sector.)

Trash Can The GEM desktop icon used to delete files or folders from the 
desktop. Once a file or folder is deleted using the trash icon, it’s gone 
forever.

.TTP The TOS-takes parameters application file extender.

Video Display A device containing a video screen that you and your 
computer use to communicate.

VT52 (Terminal) Emulator A desk accessory that acts as a communica­
tions program. When executed, it turns the ST Computer into a terminal 
linked to another computer.

Warmstart Rebooting the computer by pressing the reset button on the 
back of the computer. A warmstart only partially initializes the system.
(Compare to Coldstart.)

Wildcard A question mark (?) or asterisk (*) character used in a filespec 
to specify the search criterion. “?” matches any one character;
matches all characters to the end of the first name or extender.

Window The work area that the ST Computer uses to display files and 
folders or to run programs. The desktop allows up to four directory windows 
open at a time.

Write-Protect To mechanically prevent a disk from being formatted, 
erased, or written to. To write-protect a disk, move the write-protect tab so 
you can see through the notch.





INDEX
A
.ACC files, 61, 78
active option, 25, 61
active window, 40, 44, 66, 90 

updating, 44, 48
alert message, 28, 32, 33, 34, 35, 46, 64 
alphanumeric keys, 14
Alternate] [Help] keys, 74
Alternate] key, 14, 26-27, 80 
.APP file, 58, 72, 100 
application name, 99-100 
application type, 98, 100 
applications programs, 45, 57, 61, 75,

93, App. B
[Arrow] keys, 14, 26-27, 92, App. A 
attributes, 47, 64-65 
audio feedback, 81 
auto-repeat, 13, 80

B
[ \ ] key, 96
back panel, computer, 5, 15-17
[Backspace] key, 92
backup disk, 11, 34, App. B 
batteries, clock, 6-7, 18

installing, 6-7
baud rate, 83
Baud Rate selector, 83 
bee icon, 21- 
bell button, 81 
bit, 84
Bits/Char selector, 84
Blitter chip, 75
Blitter option, 75 
bombs, App. B 
boot disk, 11, 91, App. B 
byte, 19, 65, 69, 84

available, 64, 67 
used, 39, 64

c
calculator keypad, 14 
canceling a selection, 24

icons, 24
menu options, 25

cartridge, 17, 70
slot, 17

clicking, 23
clock, 6, 18

batteries, 6-7, 18
clock/calendar, 63, 69, 79-80

windows, 79
close box, 44, 66
Close option, 66
Close Window option, 44, 66
closing

folders, 66
windows, 44, 66

[Clr Home] key, 27
coldstart, 13
Color selector, 85
Confirm Copies option, 51, 72
Confirm Deletes option, 53, 72 
connecting the system, 5-10
Control] [C] keys, 47
Control] key, 14, 80

Control Panel desk accessory, 61, 79-86
CONTROL.ACC file, 77
controlling the mouse pointer, 21-22,

26-27, App. A
copying

disks, 34-36, 52
files and folders, 50-53
name conflict, 53
to folders, 50, 52

creating folders, 48, 65
cursor, 13, 14

text, 14
vertical, 47, 92

customizing your desktop, 89-91

D
daisywheel printer, 85
data file, 45, 46-47, 71-72, 98
data file icon, 45, 57
dating files and folders, 68, 79-80
default, 27, 82
[Delete] key, 92
deleting files and folders, 38, 53, 64, 68
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desk accessory, 61-62, 77-87, 91 
Control Panel, 61, 79-86 
installing, 61, 77, 91 
VT52 Emulator, 61, 87 
window, 77

Desk menu, 61-62, 78 
Desktop Info option, 62 
DESKTOP.INF file, 74, 91 
destination disk, 34-35, 52 
dialog box, 27, 28, 32, 47, 48, 51, 53, 58, 

62, 63, 64, 65, 66, 70, 71, 72, 73, 74, 
89, 91-98, 99 
editable, 91-98 

dialog button, 27, 28
default, 27

directory, 39, 43, 44, 45, 48, 52, 57, 
59-60, 64, 68-69 
main, 39, 59 
root, 59-60 
scrolling, 43, 93 
updating, 44, 48, 52

directory line, 93, 95-98
disk, microfloppy, 11, 12, 19, 21, 29-36, 

37, 44, 45, 48, 62, 66, App. B 
backup, 11, 34, App. B 
boot, 11, 91, App. B 
copying, 34-36, 52 
destination, 34-35, 52 
double-sided/single-sided, 19, 28, 30, 
31-34, 36, 52, 66 
erasing, 31, 35, 66 “ 
formatting, 31-34, 66-67 
hierarchy, 60 
inserting, 11, 29 
labeling, 32, 66-67 
removing, 13, 29 
renaming, 66, 89 
source, 34-35 
write-protecting, 30

disk drive, 6, 28-29, 30, 37, 48 
busy light, 6, 12, 29 
double-sided/single-sided, 5, 28, 31, 
32, 34, 36 
drive A, 5, 11, 28-29, 37, 59, 61, 70, 
74, 91, 100 
drive B, 10, 17, 28-29, 37, 59, 70 
drive c, 17, 70 
drive C, 17, 70

external floppy, 10, 17, 28-29, 37
connecting, 10

hard disk, 17, 74
connecting, 17

internal, 5, 11, 28-29, 37
port, 10, 17
power to, 6
RAM disk, 29

disk icon, 21, 28, 37, 38-39, 52,
70-71, 89
installing, 70-71
labeling, 70-71, 89
opening, 38-39, 63
removing, 71

disk identifier, 39, 49, 59-60, 70, 95-96
Diskcopy procedure, 34-36
displaying files, 67-69
DMA port, 17
document file, 57
document type, 98, 99-100
dot matrix printer, 85, 86
double-clicking, 23, 26, 46, 63, 80-81,

App. A
[Down Arrow] key, 92
dragging, 26, 27, 54-56, App. A
drive identifier, 70, 89
Duplex selector, 84

E
editable dialog box, 91-98
editable text field, 92-93, 95
EMULATOR.ACC file, 77
[Enter] key, 14
erasing disks, 31, 35, 66, 67
error signal, 81
[Esc] key, 44, 92
expansion board installation, 18
extender, 47, 48, 57-58, 69, 72

.ACC, 61, 78

.APP, 58, 72, 100

.PRG, 57, 58, 72, 100

.TOS, 58, 72, 100

.TTP, 58, 72, 100
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fan, 16
vents, 5, 6, 16, 18

fast boot, App. B
file, 37, 45-47, 48, 50-53, 57-58, 63-65

attributes, 47, 64-65
copying, 50-53
dating, 64, 68, 79-80
deleting, 38, 53, 64, 68
naming, 57-58
opening, 46-47, 63

data files, 46-47
program files, 46

renaming, 47, 64
selecting, 46, 54-56, 93-94
size, 64, 68

File menu, 31, 38, 63-67
filename, 47, 53, 57-58, 64, 68

changing, 47, 64
filespec, 95, 96-98
finger/key icons, 80
folder, 37, 39, 48-53, 59-60, 65, 93-96

closing, 44, 66
copying, 50-53
copying to, 50, 52
creating, 48, 65
dating, 65, 68, 79-80
deleting, 38, 53, 68
levels, 48, 65
naming, 48, 58, 65
opening, 44, 48-49, 59-60, 63, 94
renaming, 48, 65
size, 65
symbol, 68

Folder icon. 48, 50
Format option, 31, 34, 66-67
formatting disks, 31-34, 66-67
full box, 41
function keys, 14

G
GEM, 20. 62
GEM applications, 57, 58, 62, 100
GEM desktop, 12, 20-21, 28, 37, 45, 61,

73- 74 , 89 -91, App. B
customizing, 89-91
saving. 73-74, 91

ghost outline, 26, 41, 42, 55, 56 
graphics, 75, 82, App. C

H
hard disk drive, 17, 74, 91 

connecting, 17
port, 17

[Help] key, 87
high-resolution mode, 73, 82
highlighting, 24, 25, 26, 50

icons, 20-21, 37-38, 45, 48, 67, 68, 89 
canceling, 24 
data file, 45, 57
disk, 21, 28, 37, 38-39, 52, 70-71, 89
folder, 48, 50
program file, 45, 57, 58
trash, 21, 37-38, 53, 89

inactive option, 25, 61
inactive window, 40
information line, 39
[Insert] key, 26, 27
Install Application option, 71-72, 98 
Install Disk Drive option, 70-71 
installing

applications, 46, 71-72, 98-100 
clock batteries, 6-7
desk accessories, 61, 77, 91
disk drives, 70-71
printers, 85-86

integrated circuits, 19 
interference, 15, App. B 
item selector, 93-98

joystick, 15
ports, 7, 8, 15

K
keyboard, 7, 8, 13-15, 21, 26-27, App. B 

adjustable legs, 8, 14 
connecting, 8 
jack, 8. 17 
power light, 6, 12

keyboard response, 80
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keys, 13
alphanumeric, 14
[Arrow], 14, 26-27, 92, App. A 
calculator keypad, 14 
function, 14

keytop button, 81 
kilobyte, 19

L
labeling disks, 32, 66-67
laser printer, 17
Left Arrow] key, 92
eft side panel, computer, 8, 17 
levels of folders, 48, 65 
low-resolution mode, 73, 82

M
magnetic media, 29-30, 31 
main directory, 39, 59 
mains lead, App. E
maintenance, computer, App. B
MEGA ST Computer 

color palette, 82 
connecting, 5-10 
jack, 15 
memory, 19, 62, 78, App. C 
ports, 15-17 
power light, 6, 12 
problems, 12, App. B 
specifications, Apps. C, D 
switching off, 13 
switching on, 11-12, 62, 78 
unpacking, 5
working environment, 5, App. B 

medium-resolution mode, 73, 82 
megabyte, 19 
memory, 19, 62, 78, App. C 
menu bar, 20, 21, 22, 24-25, 42, 61-75 
MIDI, 16

ports, 16
modem, 16, 82-83, 87

port, 16, 82-83, 86, 87 
modifying palette colors, 82 
monitor, 9, 17, 73, 80, 81, 82, App. B 

connecting, 9 
high-resolution monochrome, 9, 17, 
73, 82 
jack, 9, 17 
resolution, 72, 73, 82

130

RGB color, 9, 17, 73, 81
mouse, 7, 21-22, 58, App. B 

connecting, 7, 21 
error, 81 
ports, 7, 8, 15, 21 
using, 21-23

mouse buttons, 23
left, 22, 23, 24, 25, 26, 27, 40, 43 
right, 27

mouse double-click response, 80-81 
mouse pointer, 20, 21-22, 23, 24-27,

38, 41
controlling from the keyboard, 26-27, 
App. A
controlling with the mouse, 21-22, 
App. A
positioning, 24

move bar, 40, 42, 59
moving windows, 42

N
name, 57
name conflict, 53
naming

disks, 32, 66-67
files, 57-58
folders, 48, 58, 65

New Folder option, 48, 65

palette boxes, 82 
palette control, 81-82 
Paper Type selector, 86 
parallel printer, 16, 86 
parameter, 58 
Parity selector, 84

o
on/off switch, 16
one-drive system, 28-29, 30, 36, 37, 51
Open option, 38, 46, 48, 63
opening, 63

data files, 46-47
disk icons, 38-39, 63
folders, 48-49, 59-60, 63, 94
program files, 46-47, 63
windows, 37, 38-39

Options menu, 70-75 



pathname, 57, 59-60, 93, 95-96 
peripherals, 15-17, 82-86 
pixel, 26, 86
Pixels/Line selector, 86 
positioning the mouse pointer, 24 
.PRG file, 57, 58, 100
Print Screen option, 74, 85 
printer, 16, 47, 74, 85-86 

daisywheel, 85 
dot matrix, 85, 86 
laser, 17 
parallel, 16, 86 
port, 16, 86 
serial, 16, 82-83, 86

Printer Config, 85-86
Printer Port selector, 86
Printer Type selector, 85 
printing, 85-86 

data files, 47, 63 
screens, 74

program, 29, 45
program file, 45, 48, 58, 72, App. B 
program file icon, 45, 57, 58 
prompt, 47

Q
[Q] key, 47
Quality selector, 86

R
rabbit/turtle icons, 80 
RAM, 19, 29, App. C 
RAM disk, 29
Random Access Memory, 19
Read Only Memory, 19
Read-Only attribute, 64
Read/Write attribute, 64-65, 78 
renaming

disks, 66, 89 
files, 47, 64 
folders, 48, 65

reset button, 16
resetting the computer, 13, 16 
resolution, 72, 73, 82

high, 73, 82 
low, 73, 82 
medium, 73, 82

resting mouse/running mouse icons, 
80-81

retracting a menu, 22, 25
[Return] key, 13, 14, 27, 28, 47, 92 
reverse shading, 24
[Right Arrow] key, 92 
ROM, 19, 20, App. C 
root directory, 59-60 
RS232 Config, 82-84 
RS232 devices, 16, 82 
Rt/Cts selector, 84 
rubber-band box, 54-55, 56 
running programs, 46, 58, 63, 77

s
Save Desktop option, 73-74, 91, 100 
saving the desktop, 73-74, 91 
scroll arrow, 40, 43 
scroll bar, 40, 43 
scroll box, 43 
scrolling windows, 43 
selected line, 94 
selected option, 67 
selecting, 23-25, 26, 54-56

desktop items, 24, 37, 46, 54-56 
dialog buttons, 27, 28
menu headings and options, 24-25, 61 
multiple items, 54-56

serial printer, 16, 82-83, 86
Set Preferences option, 72-73 
Set Screen Resolution option, 73 
[Shift] key, 14, 26, 56, 80 
shift-c icking, 54, 56
Show as Icons option, 68
Show as Text option, 68
Show Info option, 47, 63, 66 
showing data files, 47, 63 
size box, 41 
sizing windows, 41 
slow boot, App. B
Sort by Date option, 69
Sort by Name option, 69
Sort by Size option, 69 
Sort by Type option, 69 
sorting items, 57, 69, 93 
source disk, 34-35
[Space Bar] key, 47



storage capacity, 19, 64, App. C 
cartridge, 17 
double-sided disk, 19, 30, 67 
single-sided disk, 19, 30, 67 
RAM, 19, App. C 
ROM, 19, App. C

Strip Bit selector, 84 
subdirectory, 59-60 
switching off the system, 13 
switching on the system, 11-12, 62, 78

[Tab] key, 92
timing-out, 74
top panel, computer, 5, 6, 16, 18
TOS, 20, 57, 58, 60, 62
TOS application, 58, 100
.TOS file, 58, 100
TOS-takes parameters application,

58, 100
tracks, 29
trash icon, 21, 37-38, 53, 89
troubleshooting, App. B
.TTP file, 58, 100
two-drive system, 28-29, 31, 34-35, 37

u
[Undo] key, 87
unpacking the computer, 5
[Up Arrow] key, 92
updating windows, 44, 48, 52

V
video display, 9
View menu, 67-69
viewing menu options, 61
VT52 Emulator desk accessory, 61, 87

scrolling, 43
sizing, 41
updating, 44, 48, 52

working disk, 34, 91
write-protect notch, 29-30
write-protecting disks, 30, 34

X
Xon/Xoff selector, 84, 86

W
warmstart, 16, 73
wildcards, 96-98
windows, 37, 38-44, 66, 67, 90

active, 40, 44, 66, 90
closing, 44, 66
inactive, 40
moving, 42
opening, 37, 38-39
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CUSTOMER SUPPORT
Atari Corporation welcomes questions about your MEGA ST Com­
puter or any other ATARI Computer product. Write to:

ATARI Corporation
Customer Relations
RO. Box 61657
Sunnyvale, CA 94088

In the United Kingdom, write to:

Atari Corporation (UK) Ltd.
Customer Relations
Atari House
Railway Terrace
Slough, Berkshire SL2 5BZ

Please write the subject of your letter on the outside of the envelope.

ATARI User Groups are outstanding sources of information on how to 
get the most from your ATARI ST Computer. To receive a list of user 
groups in your area, send a self-addressed stamped envelope to:

ATARI Corporation
User Group List
RO. Box 61657
Sunnyvale, CA 94088

In the United Kingdom, write to:

Atari Corporation (UK) Ltd.
User Group List
Atari House
Railway Terrace
Slough, Berkshire SL2 5BZ

133



////////////////







<<ZZZ 'Z zz







■W

REV.A
1987 9 C. C.

C100296-001
C033504-0A1

I ' 
® ft at®

A ATARI
Copyright ©1987, Atari Corporation 
Sunnyvale, CA 94086 
All rights reserved.
Printed in Taiwan

/ %v// y


